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Picarro Notices 

Thank you for purchasing a Picarro product. Your Picarro system is a quality product that has 
been designed and manufactured to provide reliable performance. 
This User Manual (UM) is an important part of your purchase as it will help familiarize you with 
the system and explain the numerous features that have been designed into it. Please read this 
manual thoroughly before using your Picarro system. 
Please contact Picarro or your authorized Picarro distributor should you have questions regarding 
specific applications or if you require additional information. 

DISCLAIMER AND RESERVATION OF RIGHTS 
Picarro has prepared this manual solely for the information and use by its customers as a guide 
for the selection, installation, operation, and maintenance of the products described. 
EXCEPT AS PROVIDED IN THE TERMS AND CONDITIONS OF SALE FOR PICARRO 
PRODUCTS, PICARRO ASSUMES NO LIABILITY WHATSOEVER, AND PICARRO DISCLAIMS 
ANY EXPRESS OR IMPLIED WARRANTY, RELATING TO SALE OR USE OF PICARRO 
PRODUCTS, INCLUDING LIABILITY OR WARRANTIES RELATING TO MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE. 
Picarro reserves the right to change or update the contents of this manual and the specifications 
of its products at any time, without notice. Picarro has endeavored to include information that is 
current and accurate as of the date of the publication or revision of this document, but Picarro 
does not guarantee that this document is error free or that it is accurate with regard to any 
particular specification. 
Picarro expressly reserves all intellectual property rights, including all intellectual property rights 
relating to any product described in this manual. This document does not grant any license, 
express or implied, by estoppel or otherwise, to any intellectual property rights of Picarro or any 
third party. 

PATENTS 
The products described in this manual are subject to Picarro patents and patents pending. 
Information about Picarro patents applicable to these products is available at 
www.picarro.com/company/patents 

TRADEMARKS 
Picarro and the Picarro logo are trademarks of Picarro, Inc. 
Windows® is a trademark of Microsoft Corporation 
Excel® is a trademark of Microsoft Corporation 
Swagelok® is the trademark of Swagelok Company 
Snoop® is a registered trademark of Swagelok Company 
 
 
 
 
Copyright © 2024 Picarro, Inc. All rights reserved. 

 

https://www.picarro.com/company/patents
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1. Introduction

1.1 Intended Use 
The G2103, G2308, G2508, and G2509 analyzers measure concentrations of 
N2O, NH3, H2O, CH4 and CO2 simultaneously and precisely using Picarro’s 
patented Cavity Ring-Down Spectroscopy (CRDS) technology. The analyzers can 
be deployed in a lab or in the field, allowing in-situ ppb and ppm analysis of 
ambient/trace concentrations variously of N2O, CO2, NH3, CH4, and H2O. 

The analyzers enable simultaneous measurements with negligible drift over 
months of operation. They feature Picarro’s unique algorithms to correct for the 
dilution and spectroscopic broadening effects of H2O vapor, reporting N2O, CH4, 
NH3, and CO2 as both whole air and dry mole fractions. 

This manual groups together the G2103 fast ammonia instrument with the family 
of G2000 N2O analyzers because of similarities in the dynamics of measuring 
ammonia gas (all but the G2308 measure NH3).  

Throughout this manual, you will see the following icons that help distinguish 
whether a piece of text is relevant to one, two, three, or all of the analyzers 
discussed:  

The black icon identifies material pertaining to the G2103 

The teal blue icon identifies material pertaining to the G2308 

The green icon identifies material pertaining to the G2508 

The red icon identifies material pertaining to the G2509 

Note that Grayed out versions of the G2308 and G2508 icons 
refer to use cases that are compatible, but not typical. 

Table 1 below compares the features of each model. 
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Table 1: G2103/G2308/G2508/G2509 Feature Comparison 

Species 
Measured NH3, H2O, CO2 N2O, CH4, H2O N2O, CO2, NH3, 

CH4, H2O 
N2O, CO2, NH3, 
CH4, H2O 

Flow Rate > 1.5 SLPM 230 SCCM 230 SCCM 1.3 SLPM 

Ammonia 10-90 
Response Rate 

Standard, 120 
secs N/A >2 min <2 min 

High Methane 
Range (up to 
800 ppm) 

NA By upgrade 
request 

By upgrade 
request Standard 

Ammonia range 

Guaranteed 
range 0–500 ppb 
Operational 
range 0–10 ppm 
Extended range 
0–50 ppm 
(Optional) 

N/A 0-2 ppm 0-2 ppm

Supported 
Modes G2103 G2308 

G2308, G2508, 
G2608, G2508 
HR Methane 

G2508,  G2508 
HR CH4 (both 
with FR 
ammonia) 
G2509 fast 
NH3.* 

O2 sensor 
upgrade? No Yes Yes No 

Recirculation 
Possible? Limited cases** Yes, with A0702 

pump 
Yes, with A0702 
pump Limited cases** 

Sample 
Handling 

Low reactivity 
material*** All SS All SS Low reactivity 

material*** 

Typical 
Applications 

Indoor and 
atmospheric air 
quality, 
Livestock 
facilities, Vehicle 
emissions  

Soil flux, 
Ambient 
measurement 

Soil flux, 
Ambient 
measurement 

Ambient indoor 
measurement, 
Livestock 
facilities 

Inlet Filter S1021 Teflon S1020 Stainless 
Steel 

S1020 Stainless 
Steel S1021 Teflon 

Inlet Connector 
(Swagelok) ¼” PFA ¼” Stainless 

Steel 
¼” Stainless 
Steel ¼” PFA 

Recommended 
Multiposition 
valve 

A0311-S A0311 A0311 A0311-S 

* N2O values valid when NH3 <2 ppm.

**Leak-tightness and pump diaphragm emissions not guaranteed—only appropriate for 
recirculation in large spaces with appropriate pump outlet fittings (not provided). 

*** Inlet filter Teflon; inlet manifold SS; tubing Teflon, cavity SilcoNert-coated. 
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1.2 System Overview 
Analyzer 
Figure 1 shows the analyzer front and back panels. More detailed information on 
panel features, functions, and connections are in Section 4, Hardware Setup. 

 

Figure 1: G2308/2508 Front/Back Panels 

Pump Compatibility 
The G2308 and G2508 instruments are fully compatible with low-leak recirculation 
using the A0702 pump and associated tubing and hardware. The G2509 has 
sample handling downstream of the cavity that makes it less compatible with this 
form of recirculation. Accordingly, we recommend A2000 pump broadly for the 
G2509 and G2103 instruments. The A2000 pump can be set up to recirculate 
using an outlet fitting (see APPENDIX C – Setting up Contained Pump Exhaust 
Flow for more information), with the caveat that the pump is not certified to be 
leak free or non-reactive. Accordingly, recirculation should only be done into large 
vessels where a small leak or contamination isn’t of material concern. Likewise, 
the A0702 pump can and could be connected to the G2509 instrument, but its 
purpose as a low-leak, low-reactivity device is partially offset by the lack of 
equivalent sample handling in the G2509 instrument build. For simplicity, in this 
manual we refer the user to sections about the A2000 for the G2103, G2308, 
G2508, and G2509 instruments, and the A0702 for the G2308 and G2508 only. 

Main 
Power  

Soft Power 
Button  USB Port  

PC/ 
Communication 
Ports 

Sample Inlet and 
Vacuum Ports 

Com/Valve/ 
Optional 
Ports 
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A2000 Vacuum Pump 
The A2000 vacuum pump (Figure 2) is used to maintain cavity pressure inside the 
analyzer. The pump should be connected and running whenever the analyzer is in 
use. This pump can be used with the G2103, G2308, G2508, and G2509 
analyzers. Typically, it is used with G2103 and G2509. 

     

Figure 2: A2000 Vacuum Pump – Side Views 

A0702 Recirculating Vacuum Pump 
The A0702 Pump can be used with the G2308 and G2508 instruments to 
measure gas concentrations in a recirculating closed system with extremely low 
leak rates and well-controlled pump materials compatibility. This makes it ideal for 
monitoring gas evolution from soils, vegetation, or living organisms.  

 

Figure 3: A0702 Recirculating Vacuum Pump 

  

Compatibility 

 

Compatibility 
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1.3 Analyzer Specifications 
 

 
NOTE 

Check your order to determine which specifications listed below apply to your 
system. 

 

Table 2: G2103/G2308/G2508/G2509 Specifications 

Parameter Specification 

Measurement Technique Cavity Ring-Down Spectroscopy (CRDS) 

Weight: Analyzer 
Weight: Pump 

20.9 kg (46 lbs.) – Should be lifted by two people. 
A2000: 6.5 kg (14.4 lbs)  
A0702: 4.5 kg (9.8 lbs)   

Dimensions - Analyzer Depth: 44.5 cm (17.5”) 
Width: 43.2 cm (17.0”) 
Height: 17.8 cm (7.0”) 
Height with Feet: 19.1 cm (7.5”) 

Dimensions – A2000 Pump Length: 27.9 cm (11”) 
Width: 10.2 cm (4”) 
Height: 19.1 cm (7.5”) 

Dimensions – A0702Pump Length: 34.3 cm (13.5”) 
Width: 19.1 cm (7.5”) 
Height: 14 cm (5.5”) 

Ambient Humidity Range < 85% RH non-condensing 

Ambient Temperature 
Range 

Operating: 10 °C to 35 °C (50 °F to 95 °F)  
Storage:    -10 °C to 50 °C (14 °F to 122 °F) 

Maximum Altitude  
(During operation) 

3,048 m (10,000 ft. – Operation) 

Front/Rear Clearance Front: 15.3 cm (6”); Rear: 15.3 cm (6”) 

Primary Gases Measured 
 
 
 
 

 
NH3, CO2,H2O 
N2O, CH4, H2O 
N2O, CO2, NH3, CH4, H2O 
N2O, CO2, NH3, CH4, H2O 
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Parameter Specification 

Sample Flowrate 
(at 760 torr (101 kPa) 

230 SCCM  
1.3 SLPM 
>1.5 SLPM 

Required Accessories Included: Pump (external), keyboard, mouse 
Supplied by Customer: LCD monitor 

Operating System  
Data Outputs 

Windows 10  
RS–232, Ethernet, USB, Analog (optional) 0-10 V 

Installation Benchtop or 48.3 cm (19”) rack mount 

Power Requirements 
Startup Power 
Steady-state Power 
 
 
Mains Supply Voltage 
Fluctuation 

100 – 240 VAC; 47 – 63 Hz (auto-sensing) 
<375 W at start-up, (Analyzer and Pump) 
120 W (Analyzer) 
150 W (A2000 Pump) 
60 W (A0702 Pump) 
±10% of the nominal voltage 

Minimum Rated Circuit 
Amperage 

10A @ 115 VAC 
5A @ 230 VAC 

Liquid Ingress Protection None 
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1.4 Acronyms 
This manual includes various acronyms. For definitions, see below:  

Table 3: Acronyms, Formulas, Units, and Symbols 

Acronym Definition 

atm. atmosphere; unit of pressure, approximately equal to atmospheric 
pressure at sea level. 1 atm. = 14.7 psi (101.3 kPa)  

cm centimeters  

CO2 Carbon Dioxide 

CH4 Methane 

CRDS Cavity Ring-Down Spectroscopy  

DAS Data Acquisition System (the Analyzer) 

ft. Length in feet;1 ft. = 12” or 12 inches (30.48 cm) 

FR Fast response 

GUI Graphical User Interface  

H2O Water, Water Vapor 

HP High Precision (typically while measuring lower concentration) 

HR High Range (typically resulting in lower precision) 

kPa Kilopascal; unit of pressure; 1 kPa = 0.145 PSI 

mm millimeters  

N2O Nitrous Oxide 

NH3 Ammonia 

OD Outside Diameter 

PFA Perfluoroalkoxy – A chemically resistant polymer, suitable for use with 
sticky and aggressive gases 

ppb parts per billion  

ppm parts per million  

PSI (psi) Pounds per Square Inch 

PSIG (psig) Pounds per Square Inch Gauge (above ambient pressure) 
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Acronym Definition 

RH Relative Humidity 

SCCM Standard cubic centimeters per minute 

SST Stainless Steel 

UM User Manual 

WLM Wavelength Monitor 

“ (as in 1/4”) Inches 

°C degrees Celsius  

1.5 Text Conventions 
The following conventions are used in the manual. 

• Italic text identifies screen names and to emphasize important text or 
certain features. 

• Bold Italic text identifies section reference links. 

• Bold text is for actions to take (such as clicking on a UI button), caution 
and warning statements, and text you should type or select in screens. 
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2. Safety 

2.1 Warning Symbols 
Icon notes and warnings are used throughout this manual. The purpose of these 
icons is to provide a visual convention to alert you important information. They 
indicate dangers to either the operator or to the analyzer, and other important 
information. 

Table 4: Warning/Information Icon Types 

Icon Description 

 
NOTE 

NOTE is important information that you should be aware of before 
proceeding. 

 
WARNING 

LASER WARNING alerts you of a laser danger. 

 
DANGER 

DANGER indicates an imminently hazardous situation that, if not 
avoided, will result in death or severe injury. 

 
WARNING 

WARNING indicates a potentially hazardous situation which, if not 
avoided, could result in death or severe injury. 

 
CAUTION 

CAUTION alerts user of a potential danger to equipment or to the user. 

 
WARNING 

HAZARDOUS VOLTAGE alerts user to areas that may expose a user to 
electrical energy that is high enough to cause injury or death. 

 
CAUTION 

HOT SURFACE alerts user to potential injury from hot surfaces. 

 
REMINDER 

REMINDER is a helpful hint for procedures listed in the text. 
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2.2 General Safety 
CDRH Certification 
This Picarro Analyzer complies with 21 CFR Chapter 1, sub-chapter J, and is 
classified as a Class 1 laser system when all panels and covers are on. 

CE Certification 
This Picarro Analyzer complies with European safety standards and the 
instrument is affixed with a CE label. This CE label is located on the back panel of 
the instrument. 

• CE: IEC EN61010-1:2010 (safety) and EN61326-1:2013 (EMC) 
requirements for electrical equipment for measurement, control, and 
laboratory use. 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result in damage to 
the analyzer and render it unsafe to operate. 

 

 
WARNING 

The analyzer is for indoor use only and has an ingress protection rating of IPx-0. 
It is NOT protected against exposure to water including dripping, spraying, 
splashing or immersion. 

 

 
WARNING 

Do not operate in an explosive atmosphere! Do not operate in the presence of 
flammable gases or fumes.  

 

 
CAUTION 

This analyzer contains no user-serviceable components except the particulate 
filter, CPU fan, and A2000 vacuum pump diaphragms and valves. To order user-
replaceable parts and access video replacement instructions, see Section 11, 
Maintenance.  

Do not attempt other repairs; instead, report all problems to Picarro Customer 
Service or your local distributor. Please contact Picarro if you have any 
questions regarding the safe operation of this equipment. 

 

 
CAUTION 

Do not replace the mains supply power cord with an inadequately rated cord. 

 

 
WARNING 

If mounting in a 19” rack, this analyzer cannot support itself using a front rack 
mount kit alone. It must be supported by a shelf, or by user-provided “L” type 
support brackets. 
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CAUTION 

Equipment Damage: Exceeding gas inlet pressure or temperature specifications 
could result in damage to the instrument. In the case of higher input pressure or 
flow, configuring a sampling bypass manifold system is recommended. 

Use a ‘tee’ at the gas inlet and exhaust the remainder of the gas stream 
appropriately. 

 

 
WARNING 

The inlet gas connector on the back panel of the Analyzer, and its immediate 
vicinity, runs hot during operation of the analyzer. Take care when connecting 
gas lines or working at the rear of the instrument to wear protective gloves or 
avoid contact with these surfaces. 

 

 
CAUTION 

Equipment Damage: Do not disconnect the AC power to the analyzer, vacuum 
line, or the AC power to the External Vacuum Pump while analyzer is operating. 
Damage may be caused by current surges if power is applied while attaching or 
removing cables. 

 

 
WARNING 

This analyzer weighs 20.9 kg (46 lbs). Use the technique described below (or 
follow your local regulations) when lifting the analyzer. 

a. Before lifting, inspect the unit for slippery substances or sharp edges. 
b. Lift with two people, one on each side of the analyzer. 
c. Crouch down and stay close to the unit. Always keep your back as 

straight as possible.  
d. Position your feet for sturdy balance. Lift with your legs, not your back.  
e. Do not twist the back while carrying the unit. Rotate direction with hip 

joints.  
f. Lower the unit by bending at the knees.  

2.3 Laser Safety 

 
WARNING 

This equipment is classified as a Class 1 laser product with an embedded 3B 
laser in accordance with EN 60825-1:2014. Do not to open the enclosure where 
this label is placed; there are no user serviceable parts inside. 

The following Laser Safety Label is affixed to the outer cover of the analyzer. 
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Figure 4: Laser Safety Label – Affixed to Outside Cover of Analyzer 

 
WARNING 

The laser is a Class 3B when exposed.  
Only operate or service this device in accordance with the instructions in this 
guide, and only open the device in an approved laser safe service area using 
appropriate laser-safety glasses. 

The following Laser Safety Label (Figure 5) is affixed to the inside of the 
analyzer: 

 

Figure 5: Laser Safety Label – Affixed to Inside of Analyzer 

 
CAUTION 

Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous radiation exposure. 
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3. Unpacking 

3.1 Inspect the Shipping Boxes 
Picarro products are inspected and tested before leaving the factory. Their 
packing containers have been designed to keep the equipment safe from damage 
during transit. 

Inspect the condition of the boxes upon arrival. The larger box includes the 
analyzer and most of the accessories. Even if the outer box shows damage, the 
inner box holding the analyzer will protect the instrument under most 
circumstances. If the equipment does appear to be damaged, photograph the 
damage and contact Picarro (email pictures if possible) as soon as possible. 

Based on the model ordered, the shipment may consist of one, two or three 
separate boxes. 

Table 5: Shipping Box Quantities by Model 

Analyzer Model 
(Typical) 

Boxes Description 

 2 Box 1: Analyzer  
Box 2: A2000 pump 

 3 Box 1: Analyzer 
Box 2: A0702 pump (if included in order)  
Box 3: Vacuum lines for A0702 pump (Refer 
to Recirculation Pump Manual 40050) 

 

 
NOTE 

Keep all packing materials so the instrument can easily be returned Picarro if 
necessary or transported to another location. 

3.2 Unpack Components 
While unpacking each shipping box: 

• Inspect each item to ensure it is not damaged.  

• If items are missing, contact Picarro. 

• Keep the shipping materials to reuse when transporting the analyzer. 

• Contact Picarro for options on transporting systems to remote labs. 
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WARNING 

The analyzer weighs 20.9 kg (46 lbs). Use the technique outlined on Page 22 
when lifting or moving the analyzer.  

 

 

Figure 6: G2103/G2308/G2508/G2509 Shipping Box Contents 

Table 6: Box One: Analyzer and Accessories 

Item (qty) Description 

Analyzer (1) Includes all the data acquisition, control, and 
communications hardware and firmware to perform 
all gas handling, spectral collection, and analysis. 

AC Power Cables (1) A power cable with connectors appropriate to your 
country is provided.  
Note: The analyzer automatically adjusts to local 
voltage.  

Control Cable Kit (1) For External Solenoid Valves. 

Nut (1) and Ferrules (2) For connecting input line to analyzer gas INPUT. 

USB 
Backup 
Software 

Analyzer 

A2000 
Pump to 
Analyzer 
Vacuum 
Hose 

A2000 Vacuum 
Pump 

Control Cable 
for External 
Solenoid 
Valves 

Connectors 
for Control 
Cable 

User Manual 
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Item (qty) Description 

Vacuum Hose (1) Hose to connect the pump to the analyzer. 

Keyboard and Mouse (1) Monitor is not included 

USB Flash Drive  Contains backup software. 

Document Packet (1)  Includes this user manual and certificate of 
compliance (not shown). 

 

 
NOTE 

Box 2 contents differ depending on analyzer model ordered. 

 

Table 7: Box Two: A2000 Vacuum Pump and Accessories (Typical for G2103 
and G2509) 

Item (qty) Compatibility Description 

A2000 Vacuum Pump (1) 
 

 Provides vacuum required for 
sample gas sequencing into and out 
of the analyzer. 

AC Power Cable (1)  A power cable with connectors 
appropriate to your country is 
provided. 
Note: The vacuum pump voltage 
must be selected. See Set A2000 
Pump Input Voltage in Section 4.3.  

Pump Manual (1)   Detailed instructions for pump. 
 

Table 8: Box Two: A0702 Pump (for G2308/G2508) 

Item (qty) Compatibility Description 

A0702 Vacuum Pump (1)  Used with the G2308 and G2508 
instruments to measure gas 
concentrations in a recirculating 
closed system. 

Ni/Ag gaskets (10)  Gaskets for VCR connections 
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Item (qty) Compatibility Description 

A/C Power Cable (1)  For pump power 

1/4” VCR to 1/4" Tube Fitting 
Adapter (1) 

 For connection to analyzer Sample 
Inlet 

1/4" VCR to 3/8” Tube Fitting 
Adapter (1) 

 For connection to analyzer Vacuum 
Port 

NPT 1/8” Male to 1/4" VCR 
Male Adapter, (2) 

 For connections to sample chamber 
Inlet and Outlet 

Swagelok VCR Manual (1)   

Pump User Manual (1)  A0702 Closed System Measurement 
Package User Manual (PN 40050)  

 

 

Figure 7: A0702 Pump and Accessories (Box 2 and 3) 

Table 9: Box Three – A0702 Additional Parts 

Item (qty) Compatibility Description 

A0702 Vacuum Lines  Vacuum lines for A0702 recirculation 
pump: 
24” flexible stainless-steel bellows tubing 
VCR, 1/4” OD (Qty 2) 
12” flexible stainless-steel bellows tubing 
VCR, 1/4” OD (Qty 1) 
(Refer to A0702 User Manual, PN 40050) 
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4. Hardware Setup 
Read this entire section before proceeding. Some of the setup instructions in this 
section are model-dependent. 

4.1 Items/Tools Required 
• Analyzer and accessories included in shipment 

• Pump (Model dependent; see specifications in Table 2) and accessories 
included in shipment 

• 5/8” open end wrench (for G2103 and G2509) 

• 9/16’’ open end wrench (for G2308 and G2508) 

• 11/16’’ open end wrench 

• Power Cords for analyzer and pump 

4.2 Installation Safety 

 
WARNING 

Two-person lift required: The analyzer weighs 20.9 kg (46 lbs). When lifting the 
analyzer, use the technique described on page 22 (or follow your local 
regulations).  

 

 
CAUTION 

When the analyzer is being integrated to an external system, the safety of that 
system is the responsibility of the assembler of that system.  

 

 
WARNING 

Equipment Damage: Do not attach electrical power to or start the analyzer until 
after attaching and turning on the External Vacuum Pump. Do not disconnect the 
vacuum line while the analyzer is running. Failure to do so could result in 
damage to the optics. 

 

 
WARNING 

Picarro sells certain USB enabled devices, such as GPS, which are approved for 
use. Do not connect USB hubs or unauthorized USB devices (except flash 
drives, mice, and keyboards) to the USB ports. Unauthorized USB devices may 
interfere with the normal functioning of the analyzer. 

 

 
Warning 

When using compressed gases, follow all appropriate safety conventions, 
including use of eye protection, physical restraint of cylinders, etc. 
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CAUTION 

Lines connected to the 1/4” Swagelok sample inlet connector must not exceed 
15 PSIG of pressure. 

 

 
CAUTION 

During installation, do not position the analyzer so that it is difficult to operate 
the electrical disconnecting device (such as an emergency off (EMO) switch or 
breaker). 

 

 
WARNING 

If mounting in a 19” rack, this analyzer cannot support itself using a front rack 
mount kit alone. It must be supported by a shelf, or by user-provided “L” type 
support brackets. 

 

 
CAUTION 

Use the AC power cables supplied with the analyzer or a similarly rated cable. 
Check with Picarro technical support if you have questions about power cable 
replacement. An inadequately rated power cable can result in equipment 
damage. 

 

 
CAUTION 

Cords shall be RATED for the maximum current for the equipment and the cable 
used shall meet the requirements of IEC 60227 or IEC 60245. Cords certified or 
approved by a recognized testing authority are regarded as meeting this 
requirement. The connector type used should be: IEC320 C13. 

 

 
CAUTION 

Equipment Damage: It is imperative that the analyzer have adequate ventilation 
and/or cooling to maintain the ambient temperature below 35 °C when operating. 
Do not place the pump or the instrument in any enclosure without providing 
adequate forced air flow. 

Do not plug or block any perforations in the chassis of the instrument. Do not 
put anything near the instrument that will impede the air flow. Failure to provide 
adequate airflow, especially clearance at the front and rear panels, to ensure 
proper airflow and/or cooling to the analyzer will result in overheating of the 
analyzer causing a shutdown and potential damage. There should be 6” (15 cm) 
of clearance in the front and back of the analyzer. 

To determine if the ventilation is adequate in an enclosure, monitor the temperature of 
the air near the instrument and adjust ventilation so that the ambient temperature is 
within specification. As a guide, the ambient temperature of the air around the 
instrument cannot exceed the specifications listed below. 

Thermal Specifications Min Max Description 

Ambient Operating 
Temperature 

10 °C 35 °C Worst-case environmental limits 
(unless otherwise specified) 
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CAUTION 

If the analyzer has been stored at less than 10 °C, allow the components to 
equalize to room temperature before starting the installation process. 

4.3 Analyzer Preparation 
Ventilation Considerations 
The instrument and pump require adequate ventilation in order to function 
properly. Do not plug or block any perforations in the chassis of the instrument. 
Don’t place anything near the instrument that will impede the air flow.  

Positioning 
1. Remove the analyzer and the external vacuum pump from the shipping 

container. 

2. Install the analyzer in a rack or place it on a cart or table. 

3. Place the external vacuum pump near the analyzer in a rack, or on a 
cart or table. 

4. Unpack the analyzer accessories (vacuum line, cable kit, manual, and 
certificate of compliance). 

 
NOTE 

Store the certificate of compliance in a safe place. It may be required if you 
contact Picarro for service or questions. 

5. Remove the caps from the analyzer SAMPLE inlet and VACUUM 
connection ports.  

6. Remove the caps from the pump vacuum inlet (and exhaust port if using 
an A0702 or S2000 pump). Save the caps for reuse in case the analyzer 
and pump is stored, moved, or shipped. 

Set A2000 Pump Input Voltage 
7. If using an A2000 vacuum pump, set its input voltage to the correct level 

for your area by rotating the voltage selector switch located on the side 
of the pump next to the fuse holder (Figure 8). 

 

Figure 8: Vacuum Pump Voltage Selection 

Input Voltage Selector 

Fuse 
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4.4 Connections – A2000 Pump and Gas Inlet 
Follow instructions in this section when using an A2000 pump with your analyzer. 

Pump Connections 
Refer to Figure 9 when using an A2000 pump with your analyzer. 

 

 

Figure 9: Analyzer Setup with A2000 Pump 
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CAUTION 

When working with hazardous gases, remove the pump exhaust muffler and 
adapt a tube to the vacuum pump exhaust port (shown in Figure 8) and direct the 
exhaust to a safe place for venting the mixture of sample gases. For 
instructions, see APPENDIX C – Setting up Contained Pump Exhaust Flow. 

1. Connect the provided vacuum line between the analyzer port labeled 
VACUUM and the pump vacuum inlet.  

2. If working with hazardous gases, see APPENDIX C – for instructions on 
directing the pump exhaust to a safe venting environment. 

Sample Gas Inlet Connection (SST Tubing) 
There are two types of sample Inlet connections which are model-dependent.  

• G2103 and G2509 analyzers have PFA sample inlet connectors.  

• G2308 and G2508 analyzers have stainless steel sample inlet connectors. 

When making a new SST gas inlet connection:     

1. Use 1/4” OD SST tubing and connector sets to connect from sample 
source to the sample inlet. 

2. Place the two ferrules inside the nut as shown below. 

 

Figure 10: Orientation of Inlet Nut and Ferrules 

3. Loosely connect the nut to the INLET on the back panel of the analyzer, 
being careful not to let the ferrules fall out. 

4. Insert the tubing into the back of the nut and through the ferrules, 
feeding it in as far as possible without deforming the tubing. 

5. Hand tighten the nut. 

6. Using a 9/16" wrench (not included), tighten the nut 1-1/4 turns. 

When reconnecting SST tubing:     

1. Inspect the ferrules. If you see any damage, replace the ferrules and 
follow the directions above for making a new connection. 

2. If there is no damage, hand tighten the connector to the analyzer 
sample inlet. 

3. Using a 9/16" wrench, tighten the nut 1/6 of a turn (60°). 
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Sample Gas Inlet Connection (PFA Tubing) 
There are two types of sample Inlet connections which are model-dependent.  

• G2103 and G2509 analyzers have PFA sample inlet connectors.  

• G2308 and G2508 analyzers have stainless steel sample inlet connectors. 

When making a new PFA gas inlet connection:     

1. Use 1/4” OD PFA tubing and connector sets to connect from sample 
source to the sample inlet. 

2. Place the two PFA ferrules inside the PFA nut as shown in Figure 10. 

3. Loosely connect the nut to the INLET on the back panel of the analyzer, 
being careful not to let the ferrules fall out. 

4. Insert the tubing into the back of the nut and through the ferrules, 
feeding it in as far as possible without deforming the tubing. 

5. Hand tighten the nut. 

6. Using a 5/8" wrench, tighten the nut 1-1/6 turns (1 full turn plus another 
60°). 

When reconnecting PFA tubing:     

1. Inspect the ferrules. If you see any damage, replace the ferrules and 
follow the directions above for making a new connection. 

2. If there is no damage, hand tighten the connector to the analyzer 
sample inlet. 

3. Using a 5/8" wrench, tighten the nut 1/6 of a turn (60°). 
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4.5 Connections – A0702 Pump and Gas Inlet 
Follow instructions in this section when using an A0702 pump with your analyzer. 

Pump and Gas Inlet Connections 
Refer to Figure 11 when using an A0702 pump with your analyzer. 

 

Figure 11: Analyzer Setup with A0702 Pump (G2308/G2508) 

1. Attach the 1/4" VCR to 3/8” tube adapter to the analzyer VACUUM port. 

2. Attach the 1/4" VCR to 1/4” tube adapter to the analzyer INLET port. 

3. Attach the two 1/4” VCR to 1/8” NPT Male adapters to the Sample 
Chamber Inlet and Outlet ports. 

4. For the following steps, insert a new 1/4” Ni/Ag gasket (Swagelok NI-4-
VCR-2) into each VCR nut before connecting (Figure 12). 

To Connect and Tighten: 

a. Turn the nut until finger-tight. 

b. Use a 3/4” wrench (backed with a 5/8” wrench) to tighten the nut 
an additional 1/8 turn. 
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CAUTION 

Always use a new gasket whenever reconnecting VCR fittings. A used gasket 
can be identified by a circular depression on the surface: 

 

 

 
 

Figure 12: Insert New Gasket into VCR Nut 

5. Connect the 12” flexible stainless steel line between the analyzer 
Vacuum port and the A0702 Vacuum port. Ensure a new VCR gasket 
is inserted into each VCR female fitting.  

6. Connect one of the 24” flexible stainless steel lines between the 
analyzer Inlet port and the sample chamber Outlet port. Ensure a new 
VCR gasket is inserted into each fitting. 

7. Connect the other 24” flexible stainless steel line between the A0702  
Exhaust port and the sample chamber Inlet port. Ensure a new VCR 
gasket is inserted into each fitting. 

  

New 1/4” Ni/Ag Gasket VCR Female Fitting 

Circular depression 
on used gasket – Do 
not re-use. 
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4.6 Electrical Connections 
Refer to Figure 13 for connection points. 

 

1. External Vacuum Port to Vacuum Pump 
2. Gas Inlet 
3. USB Ports (4 ea) 
4. Display Port 
5. COM 2 Port (Rotary valve – A0311, A0311-S) 
6. COM 1 Port 
7. DVI-D Video Monitor Port (typical) 
8. DVI-I Video Monitor Port 
9. USB Ports (2 ea) 

10. Ethernet Ports – RJ-45 (2 ea) 
11.  Audio In/Out Ports 
12.  AC Power Input and Power ON Switch 
13.  Valve Control Port (Solenoid valves) 
14.  DIO (Only for PAL autosamplers; not used with 

this instrument; not connected) 
15.  COM 3 Port (Connected but typically not used.) 
16.  Analog EIC Output (Optional upgrade) 
17.  USB for Logic Board (Not connected) 

Figure 13: Annotated Back Panel Diagram 

1. Connect a monitor to one of the DVI monitor ports at the back panel. 
The analyzer will detect the connection and adjust the resolution to 
match the monitor. 

2. Connect a mouse and keyboard to a pair of USB ports. 

3. Connect the provided AC power cable from the analyzer to the power 
source. 

 
NOTE 

The analyzer has a universal power supply that automatically adjusts to power 
sources ranging from 100-240 VAC, 50/60 Hz, 10 A max. 
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NOTE 

The A2000 pump does not automatically adjust to power sources. If using the 
A2000 vacuum pump, ensure its input voltage is set to the correct level for your 
area by rotating the voltage selector switch located on the side of the pump next 
to the fuse holder (see Figure 8).  

The A0702 has a power supply that automatically adjusts to power sources 
ranging from 100-240 VAC, 50/60 Hz, 10A max. 

4. Check that the A2000 pump voltage input switch is set correctly. 

5. Connect the provided AC power cable from the vacuum pump to the 
power source. 

6. If used, connect the valve cable from the analyzer back panel to any 
solenoid valves. 

7. If used, connect rotary valve (A0311 or A0311-S) to COM2 with its 
provided serial cable. 
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5. Analyzer Basic Operation 
This section explains how to operate the analyzer using the GUI. It describes system 
startup, shutdown, and recovery procedures, desktop features, and GUI functions. 

 
WARNING 

Using this analyzer in a manner not specified by Picarro may result in damage to 
the analyzer and render it unsafe to operate. 

 

 
CAUTION 

During operation, do not position the analyzer so that it is difficult to operate the 
electrical disconnecting device (such as an emergency off (EMO) switch or 
breaker). 

 

 
NOTE 

The illustrations shown in this chapter are for example only. What is shown on 
your instrument is dependent on the model analyzer in use and may differ. 

5.1 Startup 
1. Make sure the pump vacuum hose is connected between the analyzer 

and pump. 

 
CAUTION 

Always turn on the external pump before powering up the analyzer. This ensures 
a safe start-up sequence. 

2. Verify the power cable to vacuum pump is plugged in. 

3. Switch power on at the pump. 

4. Verify the power cable to the analyzer is plugged in. 

5. At the analyzer back panel, press the main power switch to the ON (“I”) 
position. 

6. If needed, press the round Soft Power button on the front panel. The 
indicator LED will illuminate green. 

The software will start automatically, and the analyzer will display the 
CRDS Data Viewer window (Figure 14). Data Viewer features are 
detailed in Section 6.1.  

 
NOTE 

If you get logged off of Windows at any point, use the following login 
credentials. Username: Picarro, Password: Extreme_Science! 
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The analyzer will not begin producing data until the cavity temperature and 
pressure have reached their operational set points. A message will be displayed 
in the Status Log window (see Figure 14, bottom panel) when each set point is 
reached. An explanation of the most common status log messages can be found 
in Section 6.10, Status Log Window. 

Data will be saved automatically once the analyzer starts to produce data. The 
data in the GUI is the continuous real time read out from the analyzer. User data 
is stored in: 

C:\Userdata\DataLog_User \YYYY\MM\DD, where Y=year, M=month, D=day. 
Further details can be found Section 7, File Management. 

In order to measure discrete samples (such as individual gas bags) or from 
multiple locations (when switching valves draw in ambient air from different 
heights) a separate software window (coordinator) is used to control the sample 
source and match the corresponding real time read out with the sample source. 
Depending on system configuration, coordinator programs may not be included. 

 

Figure 14: GUI/Data Viewer Screen 
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5.2 Shutdown 

 
CAUTION 

A flow of clean, relatively dry gas should always be directed to the instrument 
for several minutes prior to shutting down. Trapping a high-moisture content 
gas sample in the cavity can cause condensation damage to the mirrors as the 
instrument cools from its operating temperature. 

 

 
CAUTION 

Do not turn off the pump or disconnect the vacuum line while the instrument is 
operating. 

 

 
CAUTION 

If you have trouble turning off the analyzer software, do not use the Windows 
Task Manager to kill the process(es). Instead, double-click on the “Stop 
Instrument” icon in the Diagnostics folder on your desktop and select the default 
option to stop the software with the drivers running. See Figure 15 below. 

Flow Clean, Dry Gas (When Using an A2000 Pump) 
1. With the pump still running, switch to a source of clean, dry gas at the 

sample inlet and allow it to run until the water channel reading on the 
GUI falls below 0.2% (2000 ppm). This will prevent any damage from 
condensation to the cavity surfaces. This dry gas may be from a tank 
(target 2-3 PSIG pressure) or from a desiccant column like the DrieRite 
column, C0360, sold on store.picarro.com). 

Flow Clean, Dry Gas (When Using an A0702 Pump): 
1. For a G2308 or G2508 using an A0702 closed system pump and 

sample chamber, disconnect the sample line at the analyzer inlet, and 
connect the dry gas source to the inlet. The gas will flow through the 
analyzer, pump, and sample chamber, then out to atmosphere or a 
contained exhaust (if used). If the user wishes to not have dry gas go 
through the sample chamber, it can be disconnected. 

Shutdown 
2. Click on the Shutdown button located on the left side of the Data 

Viewer window. 

3. A window will pop-up (Figure 15) prompting the user to confirm the 
shutdown. Once confirmed, the analyzer software and hardware will turn 
off. (Note: If three options are given on an older instrument, choose the 
For Shipment option.) 

4. Manually turn off the pump(s) and dry gas (only if system requires it). 
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Figure 15: Shutdown Confirmation Pop-Up Dialog 

After clicking Yes to confirm, the analyzer software, then the computer 
OS will shut off after a few minutes. Leave any dry gas or desiccant 
attached to the inlet during this process. 

5. When the instrument fans audibly turn off, and when the green power 
button light on the front of the instrument turns off, shut off the pump 
manually from the rocker switch located on the pump. 

5.3 Analyzer Restart after Electrical Power Outage 
If power to the analyzer is cut-off for any reason the analyzer will cease operation. 
However, when the power is reapplied, the analyzer will restart automatically, the 
Picarro software tools will properly close out previous files and open new files for 
data collection so that previously collected data, instrument diagnostics and other 
parameters recorded up to the time of power outage are retained. 

If short power outages are common in the user location, Picarro recommends 
using an uninterrupted power supply (UPS) to protect the data stream and the 
health of the cavity. 

5.4 Desktop Icons and Folders 
The following icons and folders related to analyzer operation are populated on the 
Windows desktop. 

 

 

     

 

Figure 16: Desktop Icons and Folders 
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Desktop Icons 
• Start Instrument: If the instrument software is already running, this 

restarts the software. If the instrument software has been shut down, this 
starts the software. 

• Coordinator Launcher (not present on all configurations): Clicking on 
this icon opens a window that allows you to choose the proper coordinator 
to operate peripheral modules on certain analyzers.  

• Picarro Mode Switcher: When clicked, a window opens (Figure 17) that 
allows you to switch between various measurement modes. Most analyzer 
models are configured for one mode and may not include the Mode 
Switcher. If the analyzer has multiple modes, this allows the user to switch 
between them easily. See Table 1 for supported measurement modes by-
model. 

 

Figure 17: Picarro Mode Switcher 

• Picarro Controller: When clicked, opens a useful diagnostic panel 
allowing the user to see the analyzer’s internal temperatures, pressure, 
and spectroscopy in real time. This program has user-accessible functions 
but should not be used to change instrument parameters without the 
direction of Picarro support.  

• My Computer Icon renamed to the individual analyzer’s serial number 

• Data file Viewer: When clicked, a window opens that allows you to 
convert between *.dat and H5 data files and to make various graphical 
representations of your data over time periods longer than what is 
available in the software buffer. The instructions on using the Data File 
Viewer software are described in APPENDIX B – Data File Viewer. 
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Picarro Utilities Folder 
• Data Recal: When clicked, a window opens that allows you to recalibrate 

your data based on known, certified data. 

• Setup Tool: When clicked, a window opens that allows you to edit various 
settings for your analyzer (See APPENDIX A – Setup Tool and 
Communication for information. 

• Data file Viewer: (see above) 

Diagnostics Folder 
• Stop Instrument: When clicked, a window opens that allows you to turn 

off the analyzer in an emergency event. Upon clicking on this icon, the 
following window will pop up. Please see Section 5.2, Shutdown to shut 
down the analyzer under normal circumstances. 

 

Figure 18: Stop CRDS Software Pop-up 
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6. List of GUI Functions 

 
NOTE 

The illustrations shown in this chapter are for example only. What is shown on 
your instrument is dependent on the model analyzer in use and may differ. 

6.1 GUI Overview 
The features of the GUI in Figure 19 are described in the following sections. 

 
1. Settings, View, Tools, and Help menus 
2. Alarm Panel 
3. Digital Readouts 
4. Instrument Status 
5. Shutdown and Restart Log Buttons 
6. Data Log; Filename, and Path 
7. Status Log Window 

8. Data Source, Data Key, and Precision pull-
down menus for data window content 

9. Axis Auto Scaling 
10. Reset Data Buffer 
11. Data Buffer Level Meter 
12. Data Windows – Graphical Readouts 

Figure 19: Layout of G2103/G2308/G2508/G2509 Analyzer GUI 
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6.2 Settings, View, Tools, and Help Menus 

 
 

Figure 20: Menu Toolbar Options 

Settings Menu 
Left clicking on the Settings menu pulls down a menu that has one entry: 
Change GUI Mode from Standard to Service (or Change GUI mode from 
Service to Standard if it is already in service mode).  

This is the access point to a password protected service mode (default password 
is picarro) where additional operational and measurement parameters are 
available in the data keys. Selecting and clicking on this entry opens the Cavity 
Ring-Down Spectrometer Controller. 

View Menu 
This menu item has three entries: 

1. Lock time axis when zoomed/Unlock time axis: When locked, forces 
all graphs to display the same time scale during zoom. 

2. Show/Hide Statistics: Toggles the measurement statistics display, see 
the section Digital Readouts below. 

3. Show/Hide Instrument Status: Toggles the instruments status display. 
See the section Instrument Status, below. 

Tools Menu 
This menu item has three entries: 

1. User Calibration: Opens the password protected user calibration 
window (default password is picarro).  

Calibration slope and intercept can be entered, and their effects 
immediately seen in the data. See Section 9, Calibration for more 
information. Picarro recommends using the Data Recalibration tool 
instead of this manual User Calibration when possible, as the Recal tool 
retains a traceable record of recalibration events. 
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2. Show/Hide Sequencer GUI: Toggles the display of the external valve 
sequencer window (user may need to hit alt-tab to bring it to the front).  

Help Menu 
About: Displays the version number of the instrument. 

6.3 Alarms Panel 
This panel is used to monitor the status of the internal instrument alarms. These 
indicators are gas concentration alarms, such as CO2 Too High/Low depending 
on instrument configuration. The gas concentration alarm icons are off (grayed) 
when the respective concentrations are below a certain value, and they are 
illuminated red when the respective concentrations are above/below a certain 
value.  

 
CAUTION 

High/low alarm settings are not intended as a safety measure as configured at 
the factory, either with respect to human health or the health of the analyzer. It is 
up to the customer to determine the meaning and level of a “high” or “low” value 
based on their application. 

 

 

Figure 21: Alarm Panel 

To view the alarm set point, click on the Alarm Icon and a dialog box (Figure 22) 
will appear indicating the alarm setting and allow the user to enable it or change 
the setpoint. 
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Figure 22: Alarm Settings Dialog Box 

Type the value you wish to set the alarm to and click the OK button or Cancel if 
you do not wish to change the alarm value. If you do nothing, the dialog box will 
disappear, and the alarm value will remain unchanged. The units are consistent 
with those that appear in the GUI graph.  

6.4 Digital Readouts 
Displays the latest value recorded for the selected Data Key for each Data 
Window (Figure 23). Changing the Data Key changes the Digital Readout as well 
as the Data Window view. If the Show Statistics entry is enabled in the View 
menu, the mean, standard deviation, and slope of the data in the graph is 
dynamically calculated and indicated below the digital concentration readout. 
These numbers change to reflect statistics of whatever data is in the data window. 
Zooming into a section of existing data will show the statistics statically for that 
time period, while the digital readout above the statistics continues to update with 
the latest value. 
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Figure 23: Digital Readouts Panel 

6.5 Instrument Status 
If these parameters are enabled through the Show Instrument Status entry in 
the View menu on the main toolbar, digital readouts for Warm Box Temperature, 
Cavity Temperature and Cavity Pressure are displayed to the left of the main 
trend graphs. 

 

Figure 24: Instrument Status Panel 
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6.6 Shutdown and Stop User Log(s) Buttons 

 

Figure 25: Shutdown/Stop User Log 

Shutdown Button: 
Shuts down the analyzer. See Section 5.2, Shutdown for more information. 

Restart User Log(s) Button 
The Analyzer automatically records all data collected on the instrument as .dat 
files. These are described further in Section 8, File Management. 

To start a new data file (time-coded to the current second), click the Restart User 
Log(s) button. The new file name should be visible beneath the button in a few 
seconds. 

Data Log Filename and Path 
The filename and path of the active data log is displayed in this pane. The 
indicator is grayed-out when there is no active data log before gas measurement 
reporting begins. A new file is generated when the instrument starts reading gas 
concentrations, (e.g., “153719”) and subsequently at 1 hour increments (e.g., 
“163719”, “173719”). A new day folder (e.g., “2021\04\24”) will be generated at 
midnight, as will month and year folders at the appropriate times. 

 

Figure 26: Data Log Filename and Path Panel 
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6.7 Data Window 
The data window displays a graph of any stream of data vs. system time, with a 
format of hh:mm:ss. The user can select which data streams are displayed using 
combinations from the Data Source and Data Key pull down menus. The 
precision displayed can be adjusted using the Precision menu. Auto-Scaling of 
the Y-axis is also available. Clicking any Autoscale button autoscales its Y-axis if 
the plot hasn’t done this automatically. 

  

Figure 27: Data Window Panel 

6.8 Data Source and Data Key Pull Down Menus 
Data Source and Data Key menus (Figure 28) enable selection of the data stream 
that is viewed in the data window.  

• Gas concentrations if ‘instrument Analysis’ (where instrument represents 
the system installed) is selected. 

• Sensor Readings: If Sensors is selected, the analyzer’s optical cavity 
pressure or temperature can be viewed, as well as the temperature of the 
electronics of the analyzer (DASTemp, not directly controlled), and the 
temperature of the analyzer’s wavelength monitor, indicated as 
WarmBoxTemp.  

Data Source, Data Key, Precision and Y-Axis Auto-Scale Controls  
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Figure 28: Data Source and Data Key Pull Down Menus 

6.9 Precision Pulldown Menu 
Click on the pull-down to select the precision displayed on the y-axis; between 0 
and 4 digits of precision or auto. The currently selected precision is displayed 
during operation. This does not affect the precision of the saved data in the data 
log files or results files. Auto precision is sufficient for nearly all applications. 

 

Figure 29: Precision Pull-down Pane 
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6.10 Status Log Window 
This window displays instrument status messages, in the following form: 
MM/DD/YYYY, hh:mm:ss, then ‘Generic message text’. 

Common Status Log Messages 
Following are the most common messages that appear: 

• Pressure Stabilizing/Locked: Displayed when the valve control system 
begins to allow flow through the analyzer and stabilizes the pressure 
inside the cavity. 

• Temperature Locked: WB (HB): When the temperatures of the 
warmbox (wavelength monitor) and hotbox (cavity) have stabilized.  

This is typically the longest step in the startup sequence. Startup: 
Depending on ambient temperature, the analyzer and its hotbox 
temperature set point, this step may take as little as 20, or as much as 60 
minutes. Restart: If the instrument is only stopped briefly, this may take a 
few seconds to a few minutes. 

• Preparing to Measure: Spectral scanning has started. Concentration 
measurements will be available in approximately 30 seconds. The 
instrument will continue to scan and report concentration measurements 
until the instrument is shut down. 

• Measuring: This is the normal mode of operation after startup has 
completed. 

 

Figure 30: Analyzer Status Log 

6.11 Data Buffer Level Meter 
The meter to the right of the Data Window (Figure 31) indicates how much of the 
internal memory of the GUI is used to retain historical data collected with the 
instrument. There is an internal limit of a finite number of points. Once that 
number of data points is collected, the buffer is full, and old data is removed from 
the buffer as new data is collected. This buffer affects only the data displayed in 
the data window, not the data stored in any files. This buffer is empty upon 
instrument startup and can also be emptied by pressing the reset data buffer 
button in the lower-right-hand corner of the GUI. 
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Figure 31: Data Buffer Level Meter and Reset Buffers Button 

6.12 Reset Buffers Button 
Click this button to clear the internal data buffer of the GUI (this clears the current 
data traces from the graphs). This has the effect of clearing all data in the data 
window. Pressing this button has no effect on any of the data log files stored by 
the instrument. 

6.13 Graph Zooming 
To zoom in on a specific region of the graph, move the cursor to the area of 
interest, click/hold the left mouse button, then drag as desired to create a box that 
covers the region of interest (see Figure 32). When the box is drawn, release the 
left button and the boxed area will automatically scale to fill the data window.  

 

Figure 32: Data Graph Zoom Function 

To zoom back out to see all data in the buffer, double-click on the left button 
within the graph display. To zoom out indefinitely, right click. To auto scale the 
y-axis of either graph, use the auto-scale buttons below the graph.  

Data Buffer 
Level Meter  

Example only. The 
species on your 
analyzer may differ. 
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To lock or unlock the time axis of each graph during zooming, select that menu 
item in the View menu. 

To pan the data in the X or Y axis: hold down the control button and drag the 
cursor using the left mouse button.  

To Zoom the X and Y axes: hover over a plot, hold down the control button and 
move the cursor up/down or left/right using the right mouse button. This feature 
can be very helpful when using the Lock time axis when zoomed option, as the 
scaling of the Y axis on a second plot doesn’t always match the desired scaling to 
observe certain types of data.  

If so, the user may hold down the control button while hovering over on a second 
plot, click and hold the right mouse button while moving the mouse forward, 
continue holding the control button, release the mouse button and pull the mouse 
backwards on the desk, click again the right mouse button and then repeat the 
forward-moving mouse movement multiple times to zoom in significantly. 
Interleaving this approach with the use of the control-left mouse button command 
makes it easy to keep centering the plot as the user zooms in. 

These pan and zoom features are often useful when time axes are locked, and 
the user wishes to align the Y axis in multiple plots.  
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7. Analyzer-Specific Considerations 

7.1 Sample Gas Handling for Ammonia Measurements 
Adsorption and Surface Materials 
Sample gas handling for ammonia measurements requires specific considerations 
due to the high tendency of ammonia to adsorb to surfaces, and for ammonium 
salts to form in filters through aerosol deposition. The high ‘stickiness’ of the 
ammonia molecule is caused by the formation of hydrogen bonds with water 
molecules adsorbed onto surfaces of sampling lines. On the one hand, adsorption 
can lead to a loss of ammonia to the inner walls of the inlet tubing. On the other 
hand, revolatilization of ammonia can also lead to strong memory effects. 

The degree of adsorption depends significantly on the type of surface material. In 
both the G2103 ammonia analyzer and the G2509 multi species gas analyzer, 
SilcoNert coated, and Teflon parts are used to reduce adsorption. For accurate 
ammonia measurements, it is crucial to also avoid stainless steel and metal 
surfaces for any gas handling parts that are attached to the inlet of the analyzer. 
Instead, Picarro recommends using PTFE (Teflon) or PFA tubing, and SilcoNert 
2000 and PTFE coated materials, and to keep the length of the sample line tubing 
as short as possible. The latter is especially important for monitoring atmospheric 
background levels of ammonia with the G2103. If the application requires longer 
sample tubes (>10 m) and/or if the analyzer is exposed to high ammonia 
concentrations, then heating the tubing might be an option to reduce adsorption 
effects. 

Flow Rate and Adsorption 
Another critical parameter is the flow rate: A higher flow rate reduces adsorption 
effects and increases the response time of the analyzer. For the G2103 ammonia 
analyzer, the flow rate is increased to 1.5 L/min compared to the 240 mL/min for 
the standard concentration analyzers (e.g., G2308 and G2508). The G2509 
analyzer operates at a flow rate of about 1.3 L/min. For some setups with long 
tubing attached to the inlet of the analyzer, it can be beneficial to increase the flow 
towards the analyzer with an additional assist pump, and to tee off to the analyzer 
immediately upstream of this pump. 
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7.2 Sample Filtration 
Internal PFA Filter Replacement Frequency 
The G2103 and G2509 ammonia analyzers have two built-in, sub-micron Teflon 
filters that remove particulates from the gas sample stream. The first filter is user-
replaceable, and it can be purchased via the Picarro webstore. To purchase, visit 
store.picarro.com and enter S1021 in the Keyword Search pane. If viewing this 
manual in PDF format, click on this direct link: Picarro Store – S1021 Particulate 
Filter. 

External PFA Filter 

For ammonia-specific work, an additional external S1021 filter should 
always be affixed to the inlet of the analyzer and replaced after two weeks of 
use. The filter can be purchased in a pack of 10 (roughly a 6 month supply), 
with part number S3174.  
The use of this external filter is critical for reducing the buildup of 
ammonium salts in the Teflon membranes, as ammonia can be revolatilized 
by ambient moisture, leading to phantom ammonia readings in ammonia-
free gas streams. The use of a third external filter reduces the complexity of the 
replacement process, so that customers do not need to shut down and open up 
the Picarro instrument to change the inlet particulate filter. As noted above, the 
internal inlet particulate filter should still be replaced yearly.  

 
NOTE 

We highly recommend discussing the best practices for ammonia 
measurements with a Picarro application scientist to ensure the highest level 
of data quality for your continuous ammonia measurement needs. To do so, 
please reach out to support@picarro.com.  

  

http://store.picarro.com/
http://store.picarro.com/For-Analyzer/G4XXX/Particulate-filter-teflon-for-NH3-HF._3
http://store.picarro.com/For-Analyzer/G4XXX/Particulate-filter-teflon-for-NH3-HF._3
mailto:support@picarro.com
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7.3 Managing Multiple Sample Sources 
Monitoring ammonia concentrations at different sample inlets requires the use of a 
manifold. The Picarro A0311-S 16-Port Distribution Manifold (Silco) for ‘sticky’ 
gases was designed to reduce memory effects: All surfaces are coated with 
SilcoNert, and a flow-through valve body ensures a continuous flow through all 
sampling lines, i.e., one gas line is routed through the valve into the analyzer and 
the remaining 15 gas lines are routed towards a vacuum pump attached to the 
manifold (Figure 33).  

For detailed information on connecting to multiple sample sources, Refer to 
APPENDIX D – External Valve Sequencer. 

 

Figure 33: Multiple Sample Handling Configuration using A0311-S 
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8. File Management 
The Picarro Analyzer generates ASCII-format text output files that are updated after 
each batch of concentration measurements is complete. The data files are stored 
primarily in UserData folders and are also mirrored in folders which retain more 
situational data. Some analyzers also produce discrete measurements stored in 
separate isotope data folders. All user data is ultimately archived, compressed, and 
retained, either shortly after the measurements or at a later point, to optimize space on 
the hard drive. 

8.1 User Data Folder 
The User Data folder is located at: 

C:\UserData\DataLog_User - with files arranged by year\month\day\hour. 

The User Data files are in a simple text format (white-space delimited) with a DAT 
file extension. By default, each file stores one hour of data. 

Using the Setup Tool, the user can select and customize the data columns, file 
length, total storage size and folder structure for the user data logs. Setup Tool is 
described in more depth in APPENDIX A – Setup Tool and Communication. 

Certain instruments may contain additional sub-folders under C:\UserData\ 
relating to time synced file formats, soil flux, or GPS data, among others. If the 
user has any questions about this file structure, they can contact Picarro Support. 

8.2 Data File Name 
The file name is generated from the analyzer serial number, the date, and the 
time when the file was started. The specific time stamp will depend upon the time 
the instrument was started and began measuring sample gas, so files seldom 
begin exactly at the top of the hour. For example: 

 

Figure 34: Example Data File Name 

• CFADS2101 is the analyzer serial number 

• 20210201 is the date, in format yyyymmdd (to allow chronological sorting 
of data files). 

Instrument Serial 
Number 

Date Time (Local) 

CFADS2101-20210201-224542Z-DataLog_User.dat 
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• 224542 is the time the file was started in the computer’s Local Time as 
displayed in the lower right hand side of the Windows OS  screen, 
22:45:42, formatted as hhmmss using a 24-hour clock. Note that the time 
stamp of samples within the file is usually recorded in UTC (GMT) relative 
to the local time. For example, an analyzer in California will usually have a 
time stamp (UTC) within the file that is 8 hours ahead of the time stamp in 
the file name itself (UTC - 8).  

8.3 Data Archive  
The archive directory is: 

C:\Picarro\G2000\Log\Archive\  

and has subdirectories: 

DataLog_Private, DataLog_EventLogs, and DataLog_Mailbox. 

DataLog_Private 
These data files contain a comprehensive list of system parameters such as 
instrument temperatures and pressure, set points and spectroscopy. This 
additional information is not broadly relevant to the user for day-to-day operation, 
but can be useful for diagnostic purposes. Files are stored by the convention: 

C:\Picarro\G2000\Log\Archive\DataLog_Private \[year]\[month]\[day]\[hour] 

The archive files are in a more efficient HDF5 format, with extension .h5. 

DataLog_EventLogs 
Event logs contain records of the operation of the instrument, the performance of 
the wavelength monitor and lasers, and record exceptional events like pressure or 
temperature instability. This is also a critical resource for Support to diagnose or 
troubleshoot an issue with an analyzer. Files are stored by the convention: 

C:\Picarro\G2000\Log\Archive\DataLog_EventLogs 
\[year]\[month]\[day]\[hour] 

DataLog_Mailbox 
The Mailbox folder contains individually zipped files which have been compressed 
to allow automated transfer via email. Unlike the folders above, this folder is not 
subdivided by year, month, and day. Email synching is described in greater detail 
in APPENDIX A – Setup Tool and Communication. 
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8.4 User Data Folder 
The User Data folder C:\UserData\ contains one or more subfolders associated 
with real-time instrument data.   

DataLog_User (all instruments) 
Raw user data is contained in the DataLog_User folder, with format: 
C:\UserData\DataLog_User\[year]\[month]\[day]\hour 

This is the most relevant folder for users of non-isotopic instruments, as this 
provides the real time data output in its most digestible form. These data files 
reflect the native time interval of the instrument, typically between 0.1Hz and 10 
Hz.  

DataLog_Sync  
Some instruments will also contain a (C:\UserData\DataLog_Sync\...) directory, 
which includes data that is evenly spaced in time as specified by the user in the 
Setup Tool, covered in APPENDIX A – Setup Tool and Communication.  This 
format is preferred by some users who need e.g. 1Hz data exactly, or who prefer 
to record smaller data files with data spaced, e.g. every 60 seconds.  

DataLog_GPS 
Some instruments may come with the ability to log GPS data, which can be found 
in this subdirectory. 

DataLog_SFP 
Some instruments may come with the soil flux processor software. Associated 
data files may be found in this subdirectory. 

8.5 Isotopic Data 
Isotopic instruments use Coordinator programs to produce discrete isotopic 
values for individual samples or injections. Each time a Coordinator is opened, a 
data file will be produced in one of two places, depending on the peripheral used, 
either: 

C:\IsotopeData (sometimes called C:\IsotopicData)   

or  

C:\Picarro\IsotopicData (sometimes called C:\Picarro\IsotopeData) 

While the coordinator program is running, individual sample value outputs will be 
populated as a new line into the coordinator window, and the respective data file.  
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8.6 File Archiving 
Picarro instruments will not delete data. Some instruments will, however, 
compress and archive older data to conserve hard drive space. Raw data file 
archiving frequency and details can be modified in the file:  

C:\Picarro\G2000\AppConfig\Config\Archiver\Archiver.ini. 

 
CAUTION 

To avoid losing data, discuss with Picarro support before attempting any 
changes to the Archiver.ini file. 

For each file type, there are various items along with some recommended default 
settings which may vary by file type: 

• Directory = C:/UserData/DataLog_Sync 

Optionally specifies which directory to find files to archive. 

• MaxCount = -1 

Specifies how many files to keep. A setting of -1 indicates that there is no 
maximum number of files. Generally, -1 is used in conjunction with a 
maximum size limit, below. 

• MaxSize_MB = 1500 

Specifies that a maximum of 1.5 GB of data is to be kept before the 
system begins to archive old data. 

• Compress = True/False 

Specifies if archived files are to be zipped – recommended setting is true 
to save hard drive space.  True means files are zipped, false means files 
are not zipped. 

• AggregationCount = 0 

If compression is set to TRUE, specifies how many files to be included in 
each zip archive. 

• StorageMode = FIFO 

First in first out. Specifies that old data is archived first. 

• Quantum = 4 

Generally, should not be changed. Specifies the files be sorted by 
year\month\day\hour in the archived directory structure. 
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9. Calibration 

9.1 Introduction 
Periodic recalibration with standards of known concentration maintains the 
accuracy of your analyzer. Using the Data Recal Software Utility (described in 
Section 9.4, Calibration Through the Data Recal Tool (Recommended)) 
enables the calibration constants to be tracked over time, thus enabling the user 
to follow system performance. 

9.2 Slope and Offset 
Every Picarro analyzer ships with a default user calibration value of 1 for 
slope and 0 for offset. While new user calibrations will likely result in changes to 
both, we recommend that only offset changes are applied during more frequent 
calibrations. 

A rule of thumb with Picarro analyzers is that their linearity seldom drifts more 
than 5% in either direction over many years, so a recalibrated slope of <0.95 or 
more than 1.05 typically reflects not instrument drift, but the uncertainty in the 
other components of a calibration, e.g., reference materials, gas delivery, or 
sample handling materials compatibility.  

If during your slope calibration, a new value of 0.9 or 0.85 is suggested by the 
Data Recal tool, please repeat the measurements of your standards, checking for 
any leaks or dilution, confirming regulators are fully flushed before use, and 
confirming that you’ve taken the certified rather than target value on your 
calibration cylinders. In most cases, such large changes in slope are a result of 
these sorts of biasing effects, and do not indicate a lack of repeatability in the 
analyzer. If your analyzer continues to suggest a large change in slope, please 
consult with Picarro Support before applying a new calibration. 

While the user can expect non-reactive gases (including surrogate gases which 
are traceable to primary standards) to be quite repeatable to better than 5% from 
use to use, the same is not always true of reactive gases. Gases like ammonia 
are typically certified with significantly larger uncertainty terms, and standards are 
expected to degrade, often significantly, over months or years. Accordingly, the 
overall health of an analyzer (e.g., laser or sensor drift) should be assessed by the 
non-reactive species reported when high quality reactive gas standards are not 
available or trusted.  
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NOTE 

If you are uncertain about the state of your current slope and offset values, 
they can be reset back to their user default values of 1 and 0, respectively. In 
your Picarro GUI, navigate to: 

Tools → User Calibration → (password: picarro) → 

Then change the slope and offset values of your parameter of interest to 1 and 
0, respectively. 

9.3 Calibration Methodology 
To perform a calibration or verification of calibration, the user simply introduces 
the calibration standard into the analyzer for a period long enough for the analyzer 
to yield a stable, typically five-minute measurement of that sample. 

 
WARNING 

When calibrating with hazardous, corrosive, explosive, or otherwise dangerous 
gases, the user should follow best practices for reducing personal exposure, 
including locating the instrument and pump near or in a vacuum hood, and/or 
venting pump exhaust flow into a vacuum hood or dump line 

Calibration Setup 
Connections from the analyzer to the gas tank 

• Always use a two-stage regulator capable of delivering 2-3 psig, and not 
exceeding 10 psig. Picarro recommends e.g., the Q1-14B-590 or Q1-14B-
580 regulator from Airgas/Scott, which can be purchased as part of the 
A0921, A0923, or A0925 gas kits from the Picarro Web Store. Enter 
http://store.picarro.com/ in your web browser, then once at the store 
homepage, enter one of the above gas kit part numbers in the Keyword 
Search field. 

• The pressure regulator at the outlet of the gas tank protects the analyzer 
from over-pressurizing. The pressure should be set to about 2 – 3 psig 
(0.14 bar – 0.2 bar). 

• The toggle valve allows rapid shutoff of the gas delivery. 

• Tubing is connected to the male inlet bulkhead thread on the back with the 
analyzer. 

• If the user is either moving a regulator from tank to tank, placing a 
regulator on a cylinder for the calibration, or calibrating for reactive gases, 
they should flush their regulator fully 2-3 times before use. Follow the 
tutorial located on the Picarro website Video Gallery. If you are viewing 
this manual on PDF, click HERE to go directly to the video. Otherwise, 
navigate to the video by following these instructions: 

a. In your web browser, enter https://www.picarro.com/, hover 
over the Support dropdown and select Document Library. The 

http://store.picarro.com/For-Analyzer/Calibration/A0921-N2-Dry-gas-kit-for-Lxxxx-analyzer.html
http://store.picarro.com/For-Analyzer/Calibration/A0923-Zero-air-dry-gas-kit-for-Lxxxx-analyzers.html
http://store.picarro.com/For-Peripherals/For-SSIM2-Standards-Delivery-Module/A0925-Zero-Air-Kit-for-SSIM2-A0314.html
http://store.picarro.com/
http://store.picarro.com/
https://www.picarro.com/videos/flushing_regulators
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Document Library homepage will open.  

b. Click on the Video button near the top of the page.  

c. When the video page opens, click on the Flushing Regulators 
link to view the video.  

 
CAUTION 

Failure to flush the regulator fully will typically result in a long, slow stabilization 
process that may take an hour or more for values that differ greatly from ambient 
air, or the gas from a previous tank. 

When switching between tanks:  

1. Disconnect the tubing from the instrument inlet.  

2. Turn off the main cylinder valve on the current cylinder. 

3. Bleed down the pressure in the regulator using best practices, typically 
by disconnecting the line from the regulator to the instrument, and 
increasing the delivery pressure until both gauges have dropped to zero. 

4. Disconnect the pressure regulator from the tank. 

5. Connect the pressure regulator assembly to the next gas tank,  

6. Flush the regulator with the new gas, following the instructions 
mentioned in the previous section. 

7. Set the delivery pressure back to 2-3 psig. 

9.4 Direct Calibration Through the Data Recal Tool 
(Recommended) 

Data Recal  
The Data Recal software utility is designed to enable users to perform a 
concentration calibration or calibration verification of Picarro’s gas concentration 
analyzer via a user-friendly interface.  

Data Recal allows the input of ten calibration points. Some of these points can be 
used for recalibration, while the remaining points can be used as quality control 
calibrants. In an ideal situation, three concentration certified standards should be 
analyzed on the system to generate CRDS-reported values for concentration. 
Standards spanning and encompassing the intended sample analysis should then 
be used to build a standard calibration curve. Parameters of this curve will then be 
used to correct the instrument readings so that they match standard values. The 
other standards will be simultaneously used for quality control, to verify other 
recalibrated values against their certified values. 
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NOTE 

The following steps illustrate the Data Recal procedure for concentration 
measurements. The user can follow the same steps for isotope measurements, 
if working with a Picarro isotope analyzer. 

Running Calibration Standards for Direct Calibration 
1. With the first standard hooked up to the inlet (typically starting with the 

lowest concentration), navigate to the main Picarro GUI, and watch until 
the calibration tank values have stabilized. Ensuring that Show 
Statistics is selected from the View menu, zoom in on a 5-minute 
stable period for a given gas species, and write down in a lab book or 
new text file the reported Mean concentration or isotope value from the 
left hand side of the screen for each species being calibrated.  

2. When complete for the first tank, remove the tank from the instrument 
inlet and close the cylinder and/or on/off toggle valve. 

3. Connect up the next cylinder and repeat the above steps for the 
remaining cylinders. 

Graphical User Interface (GUI) 
The Picarro Data Recalibration (Data Recal) software can be found in the Picarro 
Utilities folder on the desktop. The Data Recal software utility can be launched by 
double-clicking on the Data Recal icon in the folder. Shown in Figure 35 below is 
a screenshot of the window that will open. 
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Figure 35: Data Recal Software Utility GUI 

The Data Recal Software Utility consists of three sections: 

1. Numerical Input and Selection sections (Figure 36): 

Start with the first gas being calibrated, e.g., CO2. 

a. Under Certified, enter the certified value for the tank, as 
characterized by the manufacturer. Importantly, ensure that you 
do not simply enter the target concentration requested upon 
purchase. While a tank can occasionally be delivered at exactly 
the target concentration, this is very rare. Typically, the certified 
value will have more significant figures, e.g., 103.1 ppm, rather 
than 100 ppm. The example in the image below is notional, and 
thus uses round numbers. 
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b. Under CRDS reported, enter in the values noted down in a lab 
book/text file in the previous section corresponding to each 
calibration tank. Be sure to check the Used for Recal checkbox 
on the left so that the program knows to use the certified and 
CRDS reported values in the calibration curve. 

 

Figure 36: Recalibration Section of Data Recal Software Utility GUI 

2. Calibration Output Section (Figure 37): 

In the Calibration Options drop-down menu, the user can select either 
an Offset or an Offset + Slope.  

When using multiple standards, Offset and Slope is appropriate. 
Selecting Offset only is appropriate for single point scaling adjustments, 
e.g., for re-zeroing an analyzer.  

Once the new calibration parameters are calculated, the Data GUI will 
display the new values under the New Calibration column. The 
parameters that appear here will depend on the user’s initial selection. 
When the Offset + Slope option is selected, the program also calculates 
a goodness-of-fit correlation coefficient (R2). 

New change Indicator 
(asterisk) 
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Figure 37: Calibration Output Section of Data Recal Software Utility GUI  

3. Action Selection Section (Figure 38): 

In this section, the user can click on the Compute button to calculate the 
new calibration parameter(s). The compute button will be grayed out until 
values have been entered in the Certified and CRDS reported columns 
(Figure 36), and at least one pair of Certified and CRDS reported values 
selected for the calibration. Once these values are entered or selected, 
the Compute button will be active. Click Compute to calculate the new 
calibration parameters. These parameters will appear in the Calibration 
output section of the GUI, and an asterisk “*” will be displayed at the end 
of the window title line (Figure 36), indicating the new change. 

 

Figure 38: Action Selection Section of Data Recal Software Utility GUI 

Once the calibration parameters are calculated, the user can elect to 
graphically display the calibration and quality control (QC) standards in a 
graph. To do this, click Plot in the upper left corner of the window, and 
select Plot Linear Fitting from the drop-down menu, as shown in Figure 
39 below. 

 

Figure 39: Data Recalibration – Plot Linear Fitting 
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The plot that the utility will generate is shown in Figure 40; this plot will display two 
graphs. The top graph presents measurements for the recalibrated standards 
(calibration and QC), as well as a line fit through those points. The bottom graph 
shows the residuals, which shows how far each measurement is from the best-fit 
line. 

 

Figure 40: Slope of Data Recalibration 

If the user decides to accept the new calibration values based on this plot, they 
may click on the Apply New Cal button (Figure 41). 

 

Figure 41: Apply New Calibration Slope and Intercept 

The user will then be prompted to enter a Calibration Password (Figure 42). The 
default Calibration Password is picarro, all lower case. 
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Figure 42: User Authorization Dialog 

Next, a Recalibration Confirmation pop-up window will appear, displaying the 
new offset and slope (when applicable) values. This window will prompt the user 
to confirm their choice to apply these values, to avoid any inadvertent mistakes. 

 

Figure 43: Calibration Confirmation Pop-up 

When the user clicks the Yes button, the newly accepted calibration parameters 
will take effect immediately, without the need for the instrument main GUI to be 
restarted. 

Once the user accepts the new calibration parameters, the Data Recal Software 
Utility automatically gives them the option to save the new recalibration file 
(Figure 44 below). Saving these files enables the user to track the instrument 
recalibration history.  
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Figure 44: Data Recalibration Save-As File Dialog 

The recalibration file for this example would contain the information as shown in 
Figure 45 below. 

 

Figure 45: Data Recal Log File Example 
Rows 2 – 4: Values from each standard selected for recalibration. The first 
column in these rows lists the certified values, the second column lists the 
measured values, and the third column lists the recalibrated values. The number 
of rows will depend on the number of standards selected to be used for 
recalibration. 

Row 5 – Current Calibration (cc) Row: Read from left to right, lists the current 
offset and current slope value. 
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Row 6 – New Calibration (nc) Row: Read from left to right, lists the new offset 
and new slope values. The third value in this row is the R2 value, which is only 
displayed if the calibration option is Offset + Slope. 

Row 7 – Options Row: The last row displays the calibration option selected.  

If the user chooses to exit the Recal GUI before accepting the new recalibration 
values, they will be prompted to confirm their choice through a pop-up window 
(Figure 46). This window contains a warning that continuing to exit will cause the 
new calibration data to be lost: 

 

Figure 46: Recalibration Exit Confirmation Pop-up 

When the user is finished with the calibration, they can either click Clear Entries 
at the bottom of the screen, and begin entering values for the next gas species, 
ensuring to select the right variable from the Data Options dropdown, or they can 
exit the Data Recal software utility by clicking on the Exit button. 

 

Figure 47: Exit Data Recalibration Utility 

 

 
NOTE 

The Recal GUI will display an error message saying the new slope value is not 
acceptable when one of the following occurs: 

a. At least two entries in the Certified or CRDS reported columns contain 
zero-value numbers. 

b. These entries are selected to be used for recalibration. 
c. The “Offset + Slope” calibration option is selected. This error occurs 

because the entered values will lead to an erroneous zero-slope value. 
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Loading a Previous/Stored Calibration 
Saved calibration configurations can also be reloaded by clicking File in the upper 
left corner of the window (Figure 48) and selecting Load Recalibration File. 

 

Figure 48: Data Recalibration Load File 

From the load file dialogue, the user may select and open the file they wish to 
load (Figure 49).  

 

Figure 49: Data Recalibration Load File Dialog 
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9.5 Calibration Data Processing (less common, less 
direct option) 

1. The user may process the calibration results from a given .dat file(s) (see 
File Management on Page 58) and calculate the average recorded 
value for each standard. 

2. Plot these values versus the certified values from the gas supplier, and 
determine the linear relationship between the known calibration values 
and the analyzer’s reported values. A linear best-fit equation can be 
calculated from the data. 

 
NOTE 

It is important to plot the analyzer’s reported concentration on the horizontal 
axis and the gas standards’ stated concentrations on the vertical axis. 

The slope and intercept of the best-fit line through these points are the two values 
that are used to calibrate the analyzer. By determining the linear relationship 
between the known calibration values and the analyzer’s reported concentration 
values in this way, a calibration offset (slope and intercept) can be calculated to 
add a correction term to the analyzer’s factory or previous calibration. 

Entering the Calibration Setting 
Changing the analyzer’s calibration is intended to be done infrequently. Instead of 
recalibrating frequently to increase the accuracy of the data, users often just verify 
the calibration by measuring three or more gas standards and use the same 
regression procedure described here to calculate an offset by which to correct 
their data offline.  

Using the following equation in the graph in Figure 50 below, this calculation 
would be accomplished point-by-point by calculating the corrected data “y” using 
the analyzer’s data “x” so that: 

Datacorrected = 0.9874 × Dataraw + 5.7478 
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Figure 50: Linear Calibration Example 

Calibration values are input into the analyzer by selecting Tools → User 
Calibration from the main Picarro GUI, and then entering the slope and intercept 
for each species. 

 
NOTE 

User Calibration is a password-protected form, and the default password is 
“picarro.” This password can be reset in the QuickGui.ini file as previously 
described. 

The calibration will take effect immediately after clicking OK.  

Returning the Instrument to its Factory Calibration 
To return the instrument to its the factory calibration, within the Calibration Tool, 
simply set the slope to 1 and the intercept to 0 for the desired species. This 
returns the instrument to its factory settings, though this does not ensure that the 
system will read exactly as it did when it left the factory if a small amount of drift 
has accumulated over a period of time. 
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9.6 Detailed Picarro Calibration Guide 
For more detail on calibrating a Picarro analyzer, refer to the Calibration Guide 
for Picarro Analyzers. This document can be downloaded by either clicking the 
link below or entering the URL in a web browser. 

https://www.picarro.com/sites/default/files/Calibration-Guide-Picarro-analyzers-
Rev1.pdf 

9.7 Surrogate Gas Validation  
Picarro’s CRDS technology guarantees unmatched long-term stability because of 
a very precise cavity temperature and pressure control, and the ability to generate 
a clean stable frequency. Overall, this greatly reduces the need for analyzer 
calibration. For the G2103 analyzer, we recommend verifying the performance of 
the analyzer on a yearly basis. Calibrating or verifying the calibration of ammonia 
measurements is generally challenging due to the reactive nature of ammonia 
(e.g., it is difficult to keep ammonia standards stable for more than a few months). 
The Picarro G2103 ammonia analyzer was designed with this challenge in mind: 
The accuracy and linearity of the analyzer can be validated using a surrogate gas, 
in this case CO2. Carbon dioxide is a non-reactive, commercially available gas 
that has an absorption spectrum adjacent to ammonia. Therefore, the 
performance of the analyzer can be validated by measuring air standards with 
varying carbon dioxide concentrations instead of measuring ammonia standards. 
The surrogate gas validation approach ensures an easy and straightforward 
validation of the ammonia signals on the G2103.  

Zero-point validation of ammonia measurements is also challenging because 
high-grade zero air standards usually contain several ppb of ammonia. Picarro 
recommends purifying the zero air further using Phosphoric Acid Impregnated 
Activated Charcoal (PAIAC). 

 
NOTE 

More details on best practices for the surrogate gas validation and the zero-
point validation are given in our technical guide titled: Rapid Analyzer Validation 
Using a Traceable Surrogate Gas Approach. Following is the link to the 
document: 
https://www.picarro.com/Surrogate-Gas-Validation 

Also, a supplemental surrogate gas validation Excel worksheet can be used in 
conjunction with the above technical guide. Following is the link to the 
worksheet: 
https://www.picarro.com/Surrogate-Gas-Validation-Worksheet 

The link will open the worksheet in your web browser, but the file can be saved 
to your PC for opening in Excel for use. 

https://www.picarro.com/sites/default/files/Calibration-Guide-Picarro-analyzers-Rev1.pdf
https://www.picarro.com/sites/default/files/Calibration-Guide-Picarro-analyzers-Rev1.pdf
https://www.picarro.com/Surrogate-Gas-Validation
https://www.picarro.com/Surrogate-Gas-Validation-Worksheet
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10. Troubleshooting 
The following section lists problems that may be encountered during installation and 
operation of the analyzer. The corresponding step-by-step procedures provide resolution 
in most cases. If, after attempting these procedures, the problem remains unresolved, 
please contact Picarro Customer Service at (408) 962-3990 or support@picarro.com. 

10.1 Power LED on Analyzer Does Not Illuminate 
Context: Turning on the analyzer by momentarily depressing its front panel power 
switch should apply power. The green power LED is illuminated when it detects 
the correct power levels. 

1. Check that the AC power cord is attached and plugged into a working 
outlet. 

2. Check that the rear on-off switch near the AC power cord is in the ON 
position ( I ). 

3. Press and hold the front panel power switch for at least 5 seconds as 
the analyzer may take several seconds to respond. 

10.2 User Interface Program Does Not Start 
Context: The computer may be configured to start the instrument and the 
associated user interface program automatically after it completes its boot-up 
sequence, or the program may be launched using the Start instrument icon on 
the desktop.  

Communications problems with the analyzer may occur if the analyzer fails to 
initialize correctly on power up. Should the analyzer initialization process not 
complete correctly, shut down the instrument by shutting down the Windows 
operating system on the control computer: 

 
NOTE 

Do not simply restart Windows since this does not cycle the power to the 
analyzer. 

1. Using the Start menu, select the red Shut Down button and select Shut 
Down in the drop-down box under “What do you want the computer to 
do?” Wait for the shutdown to complete normally and for the computer 
and analyzer to turn off completely.  

2. After a few seconds, restart the computer by momentarily depressing 
the power button.  
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10.3 Sample Pressure not Controlled to Appropriate 
Value for Concentration Measurements 

Context: Under normal operation, the cavity pressure is automatically locked to 
the correct value by means of electronically controlled inlet and outlet valves. The 
message Pressure Locked on the front panel display and the user interface 
indicates that the cavity pressure is at the appropriate value. Should either of the 
messages Pressure high or Pressure low be displayed, the cavity pressure is 
out of its correct operating range.  

1. The Pressure low message indicates that there is insufficient gas 
available at the inlet of the analyzer. Check the inlet plumbing to the 
analyzer and ensure that the pressure at the inlet is within the 
specifications. Check for blockages in the lines, or regulators that are 
turned off, especially by removing all items upstream of the inlet to see if 
the pressure returns to the spec. If removing plumbing from upstream of 
the instrument inlet doesn’t work, the inlet particulate filter may need to 
be replaced. See Section 11.1, User-Replaceable Hardware. 

2. The Pressure high message indicates that gas cannot be removed 
from the analyzer at a sufficient rate. Check the vacuum line between 
the analyzer and the power vacuum unit for leaks. Failure of the vacuum 
pump, injecting dilution gas at excessive pressure, or excessive 
pressure at the inlet can also cause this problem. 

10.4 User Interface Program “Freezes”/Won’t Update 
Graphs as Data are Collected 

Context: The computer may become unresponsive causing the programs that 
control the analyzer to stop functioning. The computer and analyzer should be 
shut down and restarted. 

1. Re-setting the computer and the instrument requires that the computer 
be shut down and restarted. If the computer responds to the mouse, a 
normal Windows shutdown may be carried out. Use the Start menu, 
select the red Shut down button and select Shut down in the drop-
down box under “What do you want the computer to do?” Wait for the 
shutdown to complete normally and for the computer and analyzer to 
turn off completely. After a few seconds, restart the computer by 
momentarily depressing the power button. 

2. If the computer does not respond to the mouse, hold down the power 
switch on the front panel for a few seconds until the computer and the 
instrument turn off. After another few seconds, restart the analyzer by 
momentarily depressing the power button. 
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11. Maintenance 
The advanced, rugged design of Picarro Analyzers provides stable, long-term operation 
with minimal service or maintenance. With the exception of the following items, the 
analyzer and pump are not user serviceable. Should either appear to malfunction, 
please refer to the Troubleshooting Guide or contact Picarro Support. 

As described below, users may obtain preventive maintenance components as part of a 
service plan, as part of a designated PM kit, or individually from the Picarro store. 

11.1 Service Plans 
In addition to basic telephone and email support and remote diagnostics, service 
plans include an annual preventive maintenance kit and can be purchased by 
contacting sales@picarro.com. The three service plans are as follows: 

• W3101 Essential Service Plan: Free yearly maintenance kit; 50% 
discount on Field Replaceable Parts; 10-20% Discounted factory repair. 
See data sheet for complete terms and conditions.  

• W3102 Premium Service Plan: Free yearly maintenance kit; Extended 
warranty; Free factory repair; Free Field Replaceable Parts. See data 
sheet for complete terms and conditions. 

• W3103 Commercial Service Plan: Free yearly maintenance kit; 
Extended warranty; Free factory repair; Free Field Replaceable Parts; 
Loaner instrument; Free yearly prevention maintenance visit; 
Complimentary remote refresher training. See data sheet for complete 
terms and conditions. 

11.2 Preventive Maintenance Kits 
Preventive maintenance kits can be purchased by contacting 
support@picarro.com. The maintenance kits all include the following elements: 

Replacement CPU Fan; particulate filter (Stainless Steel or Teflon); dust filter; 
replacement screws for instrument cover panels; Ball-Point Hex L-Keys; Anti-
Static Wrist Strap. 

The kits come in three forms depending on the instrument being serviced. 

• S3092: Yearly Maintenance Kit for GHG, L2xxx, and EtO 

• S3093: Yearly Maintenance Kit for PI2114 

• S3094: Yearly Maintenance Kit for HAPs G2xxx User-Replaceable 
Hardware 

mailto:sales@picarro.com
mailto:support@picarro.com
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11.3 User-Replaceable Hardware 
Particulate Filter 

Particulate Filter 
The inlet particulate filter is user-replaceable. Use the following link to order 
replacements and to find the instructional video and supporting maintenance 
document. 

• Stainless Steel Filter (for all models except those that measure HF, NH3, 
CH2O, HCl and H2O2):  

S1020 Particulate Filter Kit – If viewing this manual as a paper hard 
copy, enter the following URL in your browser: 

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-
except-HF-NH3.html 

• Teflon Filter: For models that measure NH3, HF, CH2O, HCl and H2O2 

S1021 Particulate Filter Kit – If viewing this manual as a paper hard 
copy, enter the following URL in your browser: 

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-
HF._3 

• For a video or step-by-step procedures for replacing the particulate filter, 
see the following: 

o Replacing Your Inlet Particulate Filter (instructional video): or visit: 
https://www.picarro.com/videos/replacing_your_inlet_particulate_filter 

o Inlet Particulate Filter Replacement (maintenance Guide): or visit: 
https://www.picarro.com/support/documents/inlet_particulate_filter_mai
ntenance_guide 

CPU Fan 
The analyzer CPU fan is user-replaceable. Use the following link to order 
replacements and to find the instructional video and supporting maintenance 
document. 

• CPU Fan: For MI970 Motherboards: 

S0060 CPU Fan – If viewing this manual as a paper hard copy, enter the 
following URL in your browser: 

http://store.picarro.com/For-Analyzer/Parts/CPU-Fan.html 

http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-kit-all-models-except-HF-NH3.html
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-HF._3
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-HF._3
http://store.picarro.com/For-Analyzer/Parts/Particulate-filter-teflon-for-NH3-HF._3
https://www.picarro.com/videos/replacing_your_inlet_particulate_filter
https://www.picarro.com/support/documents/inlet_particulate_filter_maintenance_guide
http://store.picarro.com/For-Analyzer/Parts/CPU-Fan.html
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A2000 Pump Rebuild Kit 
The pump rebuild kit is the only component not currently sold as part of a 
preventive maintenance kit because the replacement frequency is not strictly 
annual (frequency depends on pump usage).  

The A2000 pump diaphragms and valves are user-replaceable. Use the following 
link to order rebuild kits and to find the instructional video and supporting 
maintenance document. 

• Pump Rebuild Kit: Used with SI2xxx, G2xxx analyzers (except Flight and 
Flux analyzers) 

S2009 Rebuild Kit for A2000 Vacuum Pump – If viewing this manual as 
a paper hard copy, enter the following URL in your browser: 

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-
vacuum-pump.html 

A0702 Pump Rebuild 
The A0702 recirculation pump (if used with your analyzer) is not user 
serviceable. Instead, these pumps may be exchanged once they reach the 
end of their diaphragms’ operational life. Please contact 
support@picarro.com to coordinate this exchange. 

11.4 Cleaning 
Clean the outside of the analyzer with a clean dry cloth. Only certified service 
technicians should access or clean the inside of the analyzer. 

http://store.picarro.com/For-Analyzer/Pump/Rebuild-kit-for-Picarro-A2000-vacuum-pump.html
mailto:support@picarro.com
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12. Transportation and Storage 
If the analyzer will be transported or stored, use the following procedure to prepare and 
repack it into the original packaging. 

 
CAUTION 

When shipping or relocating the analyzer, it is important to protect it from 
mechanical shocks. Failure to do so can compromise its performance. When 
shipping the analyzer, use its original packaging only. 

12.1 Shutdown and Preparation 

 
CAUTION 

A flow of clean, relatively dry gas should always be directed to the instrument 
for several minutes prior to shutting down. Trapping a high-moisture content 
gas sample in the cavity can cause condensation damage to the mirrors as the 
instrument cools from its operating temperature. See Section 5.2, Shutdown for 
specific shutdown instructions for your model analyzer. 

1. Click on the Shutdown button located on the left side of the Data 
Viewer window. 

2. A window will pop-up (Figure 51) prompting the user to confirm the 
shutdown. Once confirmed, the analyzer software and hardware will turn 
off. 

 

Figure 51: Shutdown Confirmation Pop-Up Dialog 

3. Manually turn off the pump(s) and dry gas (if used). 

4. Disconnect all tubing and electrical connections from the analyzer. 

5. To prevent contamination and possible damage to the connector 
threads, place protective caps on all gas connections. 
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12.2 Packing 
1. Place the analyzer in a plastic bag with a package of desiccant.  Seal 

the bags with tape. If shipping the pump, do the same for it. 

2. Pack the analyzer and pump in the original shipping containers ensuring 
that all the foam pieces are in place to protect the analyzer during 
shipping. 
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APPENDIX A – Setup Tool and 
Communication 

A.1 Setup Tool 
In the desktop folder called Picarro Utilities, the Picarro Analyzer Setup Tool 
can be launched by double clicking on its icon. This tool allows the user to 
configure data file saving details, including which data elements are written to 
data files, digital data output (via serial port or TCP/IP), remote data delivery (via 
email), and general GUI properties.  

Seven tabs of the Setup Tool Window are explained in the next pages in brief. A 
more in-depth description of the material is provided in the subsequent section. If 
you have any questions about the Setup Tool, please contact Picarro or refer to 
Picarro Community for further details. 

https://www.picarro.com/support/community 

 
NOTE 

Before running the Setup Tool, the instrument software and drivers must be 
stopped. 

From the desktop, open the Diagnostics folder, double-click on the Stop 
Instrument icon. The Stop CRDS Software window appears. Select the radio 
button “Stop software and driver,” then click the Stop button. 

 

Data Logger Tab 
Configuring Data File Saving Details with Data Logger 

The Data Logger tab (Figure 52) allows the user to configure various data file 
saving details, including which data elements are written to data files.   

• Data Columns: Controls which data elements are written to data files.  

• Hours of Each Log File: Controls the size of each data document.  

https://www.picarro.com/support/community
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• Enable Mailbox Archiving: Enables archiving of data in the mailbox 
folder – C:\Picarro\G2000\Log\Archive\DataLog_Mailbox 

• Archived Directory Structure: Specifies part of naming convention for 
data documents.  

• Total User Log Storage Size (GB): Specifies the size of storage allowed 
for User Data (Recent Data).  

• Mode: Changes the way the analyzer fits and displays data in the data 
viewer on the basis of gas matrix, species reported, precision, and 
dynamic range. 

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 

Figure 52: Data Logger Setup Window 

Port Manager Tab 
Managing Ports for Digital Data Output/Input and Serial Communication with Port 
Manager 
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The Port Manager tab (Figure 53) allows you to control digital data output/Input 
via serial port or TCP/IP.  

On this window, you can specify: 

• Data Streaming: The port you want your data to stream through 
(COM1/COM2/Off),  

• Valve Sequencer MPV (Multi Position Valve): The port you want to 
connect your MPV to (COM1/COM2/Off) 

For more information on the configuring for external valves, see 
APPENDIX D – External Valve Sequencer. 

• Command Interface: (COM1/COM2/TCP/Off).  

Make sure there are no COM port conflicts before clicking Apply. 

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

To learn more about Serial Communication, see Remote Data Access in 
APPENDIX A – Setup Tool and Communication. 

 

Figure 53: Serial/Socket Port Manager Window 
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Data Delivery Tab 
The Data Delivery tab (Figure 54) allows the user to schedule remote data 
delivery (email). 

• Delivery Start Time: Time of the day when data will be sent.   

• SSL: Depending on the sender’s email server, the sender can activate the 
Secure Sockets Layer (SSL).  

• Use Authentication: Turning this on will require the receiver to provide a 
password and a username to access data. Set up the password and 
Username from this window. 

• From: Sender’s email 

• To: Receiver’s email.   

• Subject: subject line of the email.  

• Data Directory: Location of the data you want email.  

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 

Figure 54: Data Delivery Settings Tab 
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GUI Properties 
The GUI PROPERTIES tab (Figure 55) allows you to set the number of graphs 
displayed and to enable the control of Valve Sequencer from the main GUI.  

Number of Graphs: Set the desired number of line graphs to be visible on the 
main GUI.  

Enable Control of Valve Sequencer: To make the Valve Sequencer menu item 
visible under the Tools menu of the main GUI: 

3. Click on Settings of the Setup Tool window, and then Switch to 
Service mode.  

4. Choose Yes next to Enable Control Valve Sequencer drop down 
menu on the GUI Properties tab.  

5. Click Apply to put changes into effect and then Exit to close the 
window. 

You should now be able to access the Show/Hide Valve Sequencer GUI menu 
from the main GUI under the Tools menu. 

 

Figure 55: GUI Properties Settings Tab 
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Command Interface – Specifying Digital Data Output 
The COMMAND INTERFACE tab allows you to specify the data elements that 
are sent via COM port/TCP (specified in the PORT MANAGER tab). Two types of 
data can be specified here:  

Output Data Source: 

• Datalog_User 

• DataLog_User_Sync (Relevant only for Flux G2311-f analyzers). 

Output Data Columns:  

• The data columns are output in the order they are checked, e.g., CH4, 
comes before CO2. Command Interface enables an external device to 
send a set of predetermined commands to a Picarro analyzer. The Picarro 
returns data or metadata on the basis of the command received. 

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 

Figure 56: Command Interface Settings Tab 
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Data Streaming – Specifying Digital Data Output 
The DATA STREAMING tab allows you to specify the data elements that you 
want to send via COM port (specified from the PORT MANAGER tab). Two types 
of data can be specified here:  

Output Data Source: 

• Datalog_User  

• DataLog_User_Sync (Relevant only for Flux G2311-f analyzers). 

Output Data Columns: 

The data columns are output in the order they are checked, e.g., CH4, comes 
before CO2. Command Interface enables an external device to send a set of 
predetermined commands to a Picarro analyzer. The Picarro returns data or 
metadata on the basis of the command received. 

Data Streaming outputs data continuously, whereas the Command Interface 
needs commands to output data. 

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 

Figure 57: Data Streaming Settings Window 
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Electrical Interface – Customizing Analog Output Channels 
The Picarro analyzer may be optionally configured with an Electrical Interface 
Card (EIC) that provides up to 8 analog signals available to the user for 
monitoring various measurements results and analyzer parameters. 

The ELECTRICAL INTERFACE tab (Figure 58) allows you to customize each 
analog output channel.  

After making the appropriate edits, click Apply to put changes into effect and then 
Exit to close the window. 

 
NOTE 

This tab will be disabled if your analyzer was not configured to work with an 
analog peripheral. 

 

 

Figure 58: Electrical Interface Settings Window 
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A.2 Remote Data Access 
Picarro Serial Communication 
The analyzer supports an RS-232 physical command interface, which can be 
used to control the instrument and to retrieve concentration data. Not all features 
of the instrument are available on the serial interface.  

For details on using the serial command interface, please see the Picarro 
Analyzer Remote Interface Programming Guide. 

To Download: 

1. Go to https://www.picarro.com/.  

2. Under the Support tab (near the home page upper-right corner), select 
Document Library.  

 
NOTE 

Registration/Login Required: Access to online User Manuals is available to all 
registered Picarro customers with login credentials. If you do not yet have an 
account, please email us at support@picarro.com to request access to the 
document library. 

3. When the Document Library page opens, enter the search terms, 
“Remote Interface” in the Search field.  

4. In the results, click on the link titled Remote Interface Programming 
Guide 40-0063 to open the manual in your browser. From there you can 
also download and save it to your PC. 

This command set may also be used across a TCP/IP interface through an 
Ethernet connection. Please contact Picarro for further details if needed. 

Remote Data Access 
Using the RemoteAccess.ini file, the analyzer can be configured to automatically: 

• Send data from the instrument to a list of e-mail accounts. 

• Measure the offset of the host computer system clock from a set of 
Internet time servers and (optionally) to resynchronize the clock based on 
this information. 

The Internet connection need not be permanent and may be a dial-up connection 
accessible via a user-supplied USB modem. The task of sending data and/or 
synchronizing the clock on the analyzer is performed using the 
C:\Picarro\G2000\HostExe\RemoteAccess.exe program. This program can be set 
up to run periodically using the Windows task scheduler at a user-configurable 
frequency. If a dial-up connection to the Internet is employed, it is used only on 
demand to minimize the connection time. 

https://www.picarro.com/
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Each time that the RemoteAccess.exe program runs, it appends information to a 
log file, which keeps a record of the results of the time synchronization and of the 
files sent by e-mail. The RemoteAccess.exe program is configurable by means of 
an initialization file, which includes information such as the login credentials for 
the dial-up connection, the e-mail account, and the list of time servers. 

The initialization file is: 

C:\Picarro\G2000\AppConfig\Config\UtilitiesRemoteAccess\RemoteAccess.ini 

It should be placed in the same directory as the executable RemoteAccess.exe. 
The file has one required section named LOGGING and optional sections named 
NTP and EMAIL. The logging section has a single key Logfile whose value is the 
path to the log file. Once this log file exceeds 64 Kbytes in length, it is backed up, 
appending a numeric extension to the file name, and a new file is opened. A total 
of ten backup log files are kept. 

NTP 
The NTP section controls querying the Internet time servers using the SNTP 
protocol (RFC4330) and the resetting of the clock on the host computer. If the 
section is not present, time synchronization is not carried out. The keys Server1, 
Server2, etc., are used to specify the URLs of the time servers. If the 
UpdateClock key is set to true, the offset is applied to the host clock. Otherwise, 
the offset is recorded, but the host clock is not changed. 

Email 
The EMAIL section controls the sending of the data files as e-mail attachments. If 
the section is not present, e-mail messages are not sent. The key Directory 
specifies the directory that contains the data files. When the program is run, files 
in this directory are sent to the specified recipients and the files are deleted. To 
avoid problems with incomplete files, programs that place files into this directory 
should do so using an atomic operation, such as a rename. The Server key is set 
to the name of an RFC2821- compliant SMTP server that sends the e-mail 
messages. 

The From key is the e-mail address from which the messages are sent. Note that 
some SMTP servers check that the source is permitted to send email while others 
allow any name in this field. The collection of e-mail addresses to which copies of 
the e-mail is sent is specified by the keys To1, To2, etc. The Subject key is used 
to fill the subject field in the email header and may be set to any string. Depending 
on the SMTP server, it may be necessary to use authentication before e-mails can 
be sent, as described in RFC2554. If such authentication is not needed, the key 
UseAuthentication is set to false. If this key is set to true, two additional keys 
Username and Password must also be specified for the e-mail account.  
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APPENDIX B – Data File Viewer 

B.1 Quick Start Guide 
The following sections introduce the user to all possible functionalities of the Data 
File Viewer in detail. This section describes the most common, simple use case. 

The Data File Viewer software allows the user to concatenate multiple one-hour 
files into one larger file, enabling the user to observe trends over several days of 
measurements. 

1. To start, translate the UserData files from DAT to H5. The Batch 
Convert option (B) allows users to select any folder containing 
instrument data from a given day. 

  

Figure 59: Batch Convert DAT to H5 – Navigation 
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2. In the source folder there are now copies of the original files translated 
into the H5 format.  

3. From File menu select Concatenate H5 Files (C) to combine the H5 
files into a time series. Take care to select exactly the same folder in the 
file viewer window. 

4. In the Select Variables window, click All to move over all variables for 
concatenation. If concatenating very long records, the user can instead 
select only a few variables by clicking the variable name on the left 
dialogue, and clicking the double arrow button. Confirm by clicking OK. 
(Figure 60). 

 

Figure 60: Selecting Variables for Concatenation 

5. The user will then be asked to confirm the file name for the 
concatenated data. The default location will be in the parent folder for 
the selected day, and the filename will by default describe the time span 
of the measurements within. Successful concatenation will lead to the 
filename automatically being displayed in the main data file viewer 
window. 
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Figure 61: Concatenated Output .h5 Filename 

 
NOTE 

You can concatenate several days into one larger file, either by following steps 
1-3 for selected folders, or by copying all their DAT files into a new folder and 
performing steps 1-5 just once. 

6. With the file now opened, the user can select how many Time Series to 
display on the screen. 

 

Figure 62: Time Series Selection Options 

7. In the new window that appears, select the variables from the Var Name 
dropdown on the right of each plot. Deselect Autoscale y if the data 
stream has a large amount of variability in the Y-axis. 

8. Please read the following sections to learn more about features of the 
Data File Viewer. 
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B.2 Data File Viewer Overview 
The Picarro Data File Viewer software is located on the desktop of the Picarro 
instrument. The software allows the user to graph and to conduct statistical 
analysis of the raw data. Additional functions include Allan Variance plot and 
quadratic or polynomial fittings. The Picarro Data File Viewer includes two main 
menus: File and New (Figure 63).  

 

 

Figure 63: Picarro Data File Viewer – File and New Menus 

B.3 File Menu 
This section describes the functions available from the Data File Viewer File 
menu. 

Open H5 
File > Open H5 File: Opens a Picarro data file (HDF5 format) for data analysis 
and visualization. After opening the data file, you can create a new time series 
plot. Refer to Section B.3, New – Time Series Plot for more information. 
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Load Config 
File > Load Config: Loads a configuration file (ini format) to restore parameters 
of a workplace. Refer to Save Configuration on Page 103 for more information. 

Unpack Zip File 
File > Unpack Zip File: Use to concatenate all H5 files inside the zip file into a 
single H5 file. Refer to Concatenate H5 Files below for details. 

Concatenate H5 Files 
File > Concatenate H5 Files: Use to concatenate multiple files and zip archives 
of H5 files into a single H5 file. Navigate to the desired folder or use the Define 
Date Range button to specify a date range of files to concatenate. (See next 
section.) 

After selecting the path of the data files, Data File Viewer will automatically search 
an H5 file in the specified zip/folder and look for all available variables in the H5 
file. The variables are then listed in the Select Variables window in the left panel 
(as shown in Figure 64), and users can use the “>>“ button to move variables to 
the right panel for concatenation.  

 
Note: this screenshot is for example only. The species selections shown on your analyzer 
may vary.  

Figure 64: Select Variables Form 
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Define Date Range 
Data File Viewer can search data files within the desired date range and then 
concatenate such files into an H5 file. 

By default, TimeZone is set to your local time zone. However, if data were taken 
elsewhere, select the time zone where data were taken. 

Select File > Concatenate H5 Files, then click Define Date Range to specify the 
desired date range as shown in Figure 65.  

 

Figure 65: Define Date Range Dialog 

Data files are saved in directory trees named by date and time option.  

Picarro software saves data in a directory tree that is named by the creation year, 
month, and day as shown in Figure 66. Select this option if the target folder has 
this file structure. This way, Data File Viewer will only search folders within the 
desired date range, which can substantially reduce processing time.  

 

Figure 66: File Structure of Data File Viewer 
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NOTE 

To save processing time, Data File Viewer does not open data files, but only 
determines data acquisition time based on the file name. 

 

  
CAUTION 

Do not define a time range for data files whose names have been changed. 

 

  
NOTE 

Data File Viewer does not concatenate data files exactly within the defined time 
range. This is because the time extracted from file name is different from the 
data acquisition time. To not miss data points, Data File Viewer expands the 
specified time range, so the resulting dataset normally has a wider time range 
than the user specification. 

Convert DAT to H5 
Select File > Convert DAT to H5 to convert a file in DAT format to HDF5 format. 
These formats are described below: 

• DAT format: DAT files accepted by DatViewer store tabular data (numbers 
and text) in plain text. 

• Each line of the file is a data record. Each record consists of one or more 
fields separated by whitespaces. 

• The first line of the data file indicates column names. 

• There must be a field “EPOCH_TIME” to store the acquisition epoch time 
(expressed as seconds since Jan 1, 1970) of the data. Otherwise, the first 
and second fields must be “DATE” and “TIME”. The “DATE” field must 
have the format “mm/dd/yyyy” or “yyyy-mm-dd”, and the “TIME” field must 
have the format “HH:MM:SS(.sss)” where (.sss) is an optional fraction of 
seconds. 

• HDF5 Format: HDF5 is a data model, library, and file format for storing 
and managing data. (See the HDF5 Home Page on the HDF Group 
website https://www.hdfgroup.org/ for more information.) When converting 
DAT to HDF5 format, Data File Viewer creates a table named “results” to 
the contained data. 

  

https://www.hdfgroup.org/
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Convert H5 to DAT 
Select File > Convert H5 to DAT to convert a file in a HDF5 format to DAT. 
These formats are described in Convert DAT to H5. 

   
NOTE 

Data File Viewer does not concatenate data files exactly within the defined time 
range. This is because the time extracted from file name is different from the 
data acquisition time. To not miss data points, Data File Viewer expands the 
specified time range.  

Interpolation 
Interpolation describes the method for constructing data points with a range of a 
discrete set of known data points. Select File > Interpolation to perform 
interpolation on a time grid with a constant interval. 

Block Average 
Select File > Block Average to divide a dataset into small blocks based on a 
user-defined block size. The average is calculated for data in each block, and the 
results are saved in a new H5 file. 

  
NOTE 

The specified block size must be greater than the average data interval. 

Because the data interval is normally not a constant (unless interpolation is 
performed), fluctuations in the data interval will affect block averaging if the block 
size is comparable to the average data interval. 
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B.4 New – Time Series Plot 
You can specify to include create time-series plots with one, two, or three frames. 
New plots display in the Time Series Viewer.  

 
Note: this screenshot is for example only. The species shown on your analyzer may vary. 

Figure 67: Time Series Viewer 

The next section describes the options available on the Time Series Viewer menu 
bar. Refer to The Time Series Viewer Canvas on Page 89 for more information on 
the Time Series Viewer UI features and options. 

B.5 Time Series Viewer Menus 
The Time Series Viewer form includes the following menus:  

 

Figure 68: Time Series Viewer Menus 
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Time Series Viewer File Menu 
Use the File menu to save a configuration or take a screenshot.  

 

Figure 69: Time Series Viewer – File Menu 

Save Configuration 
Click File > Save Configuration to open the Feature Capture form. With this 
form, you can save figure properties, expressions, filters, and other settings to a 
configuration file so that it can be easily loaded in the future.  

 

Figure 70: Time Series Viewer – Feature Capture 

  
CAUTION 

If a feature is not captured, it will be omitted when the configuration file is 
loaded. 

Depending on the features captured, loading a configuration file can have different 
effects. For example: 

• If all features are captured, a saved workplace is reproduced. 

• If Data file is not captured, saved parameters will be applied to the data file 
in memory. 

• If Expression is not captured, plots will not be transformed. 

• If X (Y) range is not captured, figures will be auto-scaled on the x (y) axis. 

Take Screenshot 
Use File > Take ScreenShot to take a screenshot of the Time Series Viewer and 
save it as a .png to a specified file. 
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Time Series Viewer Analysis Menu 
Use the Analysis menu to calculate statistics, generate a histogram, and to plot 
correlations and Allan Standard deviations.  

 

Figure 71: Time Series Viewer – Analysis Menu 

Statistics 
Use Analysis > Statistics to calculate mean, standard deviation, and peak to 
peak for all plots in the current window. 

Histogram 
Use Analysis > Histogram to generate a histogram of data as shown in Figure 
72 below.  

 

Figure 72: Histogram Window – CH4 
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Histogram Window Features 

• Red Line: A Gaussian function fitted to the histogram. Fitting results of μ 
and σ are shown in the top-left corner of the plot. 

• Bin: Specifies the number of intervals that the range of values is divided 
into. 

• Normalized: When selected, the sum of the histograms is normalized 
to 1. 

• Save data: Saves histogram data to a CSV file. 

• Save image: Saves the histogram image as a JPEG/PNG/PDF file. 

Correlation Plot 
Use Analysis > Correlation Plot to plot Y-axis data in one frame versus that in 
the other. This can be used when two or more frames exist in the current Time 
Series Plot window. See Correlation/XY Plot on Page 109 for details. 

Allan Standard Deviation Plot 
Use Analysis > Allan Standard Deviation Plot to create an Allan Standard 
Deviation plot (versus a standard deviation plot) for data in the current window. 
See Allan Variance Wikipedia page for more information. 

Time Series Viewer View Menu 
Use the View menu to view X-axis information in date-time, minute, or hour 
format.  

 

Figure 73: Time Series Viewer – View Menu 

 

  
NOTE 

When switching from Datetime to Minute or Hour, the X-axis data is subtracted 
from the earliest point shown in the panel and then converted to the desired 
unit. 

The Time Series Viewer Canvas 
The Time Series Viewer canvas (Figure 74 below) is comprised of interactive 
graphs and a variety of configuration options. 

https://en.wikipedia.org/wiki/Allan_variance
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Mouse Options and Graph Transform 
The following mouse actions can be used in the canvas graphs: 

• Left click and drag: Zooms into the selected area of the plot. 

• Left click and drag with the SHIFT key down: Pans the plot. 

• Left click and drag with CTRL key down: Zooms out from the plot. 

• Left click and drag with ALT key down: Stretches the plot. 

• Right-click: Opens an additional menu. Refer to Right-click Menu below in 
the next section. 

 
Note: this screenshot is for example only. The species shown on your analyzer may vary. 

Figure 74: Time Series Viewer Canvas 

Right-click Menu 
Right-clicking on the canvas opens a pop-up menu:  

 

Figure 75: Canvas Right-click Pop-up Menu 
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Export Image: Exports the current plot as a jpeg, png, or pdf file. 

Export Data in Current View: Exports only date/time and the selected variable in 
the current view to an HDF5 or CSV file. 

Export All Data in Current Time Range: Exports all variable columns of the 
selected dataset in the current time range to an HDF5 file. Refer to Concatenate 
H5 Files on Page 81 for more information. 

Edit Plot properties: Opens the Image Editor form (Figure 76 below), where the 
following options can be specified. 

 

Figure 76: Image Editor Form 

Image Editor Form Options: 

• Title: Edits the title of the plot. 

• Line: Specifies the line pattern of the plot. If None is selected, the data 
points will be plotted without connecting lines. 

• Marker: Specifies the marker type to indicate data points. If None is 
selected, data points will not be shown. 

• x-Axis: Min and Max: Specifies the minimum and maximum of date range 
for the X-axis. 

• x[0]: Sets the earliest time of the dataset as the minimum of the X-axis. 

• Time zone: Sets the time zone for date/time variables. This defaults to the 
local time zone. 

• Label: Specify labels for the X-axis and the Y-axis. 

• y-Axis: Min and Max: Specifies the minimum and maximum of data 
displayed on the Y-axis. 
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Dataset Name and Var Name 
An HDF5 file can store one or more tables. Each of these tables is called a 
Dataset. A table can contain one or more columns. Each column is called a 
variable (Var). 

Use the Dataset name drop down (Figure 77) to select the dataset that will be 
used for this time series graph. Use the Var name drop down to select the column 
in the dataset to use in the graph. 

 

Figure 77: Time Series Viewer Dataset Options 

Autoscale Y 
When the Autoscale Y option is selected, the Time Series Viewer will autoscale 
on the Y-axis to make sure that all data within the range of the X axis is displayed. 
This feature can make it hard to see small signals when large signals blow the Y 
axis out, so it is often advisable to deselect this checkbox for dynamic or spikey 
datasets. 

Average 
If Block is selected, a block average is calculated when you click the Do average 
button. Otherwise, a moving average is calculated. 

For a block average, Size specifies block size in unit of a minute. For a moving 
average, Size specifies subset size in unit of data points.  

 
REMINDER 

Averaging is performed after the Filter and Expression are performed. 
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Mean, Std Dev, and Peak to Peak 
The Mean, Std dev (Standard deviation) and Peak to peak fields (Figure 77) 
provide all the statistical information of data in the current view. 

Correlation/XY Plot 
The Correlation/XY Plot window (Figure 78) includes two menu items: File and 
Analysis. For details about the File menu, see Save Configuration on page 103. 

 
REMINDER 

The canvas in this plot is interactive. For details about the plot canvas, see The 
Time Series Viewer Canvas on Page 105. 

 

 

Figure 78: Correlation XY Plot 
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Analysis Menu 
The Analysis Menu (Figure 79) includes three options: Fitting, Integration, and 
Statistics. 

Fitting allows you to specify one of four fitting methods to include in the 
Correlation/XY plot: 

1. Linear fit: Specifies to fit to linear function: 

y = c1x + c0 

2. Quadratic fit: Specifies to fit to quadratic function:  

y = c2x2 + c1x + c0 

3. Polynomial fit: Specifies to fit polynomial function of degree n:  

y = Σcnxn 

4. Curve fit: Specifies to use non-linear least squares to fit an arbitrary 
function to data.  

 

Figure 79: Analysis Menu 

Integration calculates area under the curve using the composite trapezoidal rule. 

Statistics calculates mean, standard deviation, and peak to peak for data in the 
current view.  

After applying any of the above Analysis options, the results, statistics, or fitting 
function with coefficients are displayed in the lower portion of the Correlation Plot 
window (Figure 80).  

 

Figure 80: Results of Quadratic Fitting 
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APPENDIX C – Setting up Contained Pump 
Exhaust Flow 

C.1 Introduction 
The A2000 vacuum pump is shipped with a noise dampener attached to the 
exhaust port. When a hazardous gas exhaust line from the pump is needed, it 
requires replacing the noise dampener with an adapter that allows a 1/4” OD 
exhaust tubing connection. Use the following instructions if installing a pump 
exhaust line. 

 

Figure 81: A2000 Pump Vacuum and Exhaust Ports 

C.2 Tools and Parts Required 
• Long flathead screwdriver (6” x 5/16” recommended)  

• 9/16” open end wrench  

• Swagelok ISO parallel thread adaptor 1/4"-1/8” SS-400-1-2RS (Picarro PN 
22928) 

• Swagelok gasket SS-2-RS-2V (Picarro PN 22929) 

• 1/4" tubing and stainless-steel ferrule set 

• Snoop leak-detection fluid or similar soap solution 

Vacuum Port 

Exhaust Port with Noise Dampener 
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C.3 Directions 
1. Remove the noise dampener fitting from the bottom of the pump using a 

long flathead screwdriver (Figure 82).  

 

Figure 82: Pump Noise Dampener Removal 

2. Slide the adapter gasket PN 22929 onto the adapter fitting PN 22928 
(Figure 83), screw it into the pump exhaust port, and then tighten it 1/4 
turn using a 9/16” wrench.  

3. Remove the Swagelok nut and ferules from the adapter fitting to ensure 
their orientation is as shown below, then loosely reattach to the adapter. 

4. Slide the 1/4” exhaust tubing into the Swagelok nut and ferules until the 
tubing is fully seated, then using a 9/16" wrench, tighten the nut 
approximately seven flats (420 degrees). 

A guide to this process can be found on the Picarro Video Gallery here: 
https://mktg.picarro.com/acton/media/39674/picarro-video-gallery  

   
 

Figure 83: Pump Exhaust Line Adapter Fittings 

5. With the pump running on room air, apply Snoop leak detection fluid to 
the installed exhaust components to confirm that the system is leak 
tight. Instructions for leak testing using Snoop can be found in this 
video: 

https://vimeo.com/375518688 (go to time 5:20 minutes in the video) 

Adapter Fitting 
PN 22928 

Adapter Gasket 
PN 22929 

Ferule 
Orientation 

Noise Dampener  

https://vimeo.com/375518688
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APPENDIX D – External Valve Sequencer  

D.1 Introduction 
The Picarro analyzer can control two types of valves: 

• Rotary Selector Valve: Digitally controlled valve used to send selected 
flow from one of many inputs (up to 16) into the analyzer. 

• Solenoid Valve(s): DC voltage powered valve with normally open (NO) 
and normally closed (NC) positions. These can be 2-way or 3-way valves. 

Both types of valves can be simultaneously controlled through a common 
software interface called the External Valve Sequencer Software (described in 
Section D.7) which is available from the Tools menu on the GUI. 

Picarro offers two rotary valve and two solenoid valve solutions: 

• A0311, 16-Port Distribution Manifold 

• A0311-S, 16-Port Distribution Manifold (Silco) which is optimized for use 
with sticky and reactive gases. 

• S3112, 3-Way stainless steel solenoid valve with 1/4” fittings 

• S3136, 3-Way stainless steel solenoid valve with 1/8” fittings 

D.2 A0311 16-Port Distribution Manifold 
Compatibility  
The A0311 (Figure 84) is broadly compatible with all Picarro analyzers with the 
exception of those with known surface and chemical compatibility issues (such as 
the G2103, G2108, G2204, G2205, G2114, G2307, G2509, and PI2114). 

Function 
The A0311 and External Valve Sequencer GUI makes it easy to program the 
sequence and duration of sample intake from various attached sampling lines, 
flasks, or bags. The manifold is controlled using either the Picarro analyzer GUI or 
an external hand-pad (included with the A0311). 

The A0311 samples up to 16 gas sources. During operation, the selected line is 
routed through the valve into the analyzer. The 15 lines that are not selected 
terminate in the valve. 

 
NOTE 

For detailed instructions on integrating the A0311 with your analyzer, refer to the 
A0311, A0311-S, A0310 16-Port Distribution Manifold User Manual (P/N 40-0038). 
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Figure 84: A0311 – 16-port Distribution Manifold 

D.3 A0311-S 16-Port Distribution Manifold (Silco) 
Compatibility 
The A0311-S (Figure 85) is broadly compatible with all Picarro analyzers but is 
optimized for use with sticky and reactive gases in the following platforms, 
nominally: 

• G2103, G2108, G2204, G2205, G2114, G2307, G2509, and PI2114 

Function 
For users who require faster response performance, the A0311-S is a 16-Port 
distribution manifold with a flow through valve for reduced memory effects. 
Designed to optimize response time in the presence of reactive gases, the 
A0311-S uses SilcoNert® coated components, PFA tubing, and an additional 
vacuum pump. 

The sampling duration and sequence is easily programmed through the Picarro 
External Valve Sequencer GUI. This design is ideal for fast switching between 
different locations for specialty applications in Semiconductor, Pharmaceutical, 
Environmental research, and other industries.  

 
NOTE 

For detailed instructions on integrating the A0311 with your analyzer, refer to the 
A0311, A0311-S, A0310 16-Port Distribution Manifold User Manual (P/N 40-0038). 
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Figure 85: A0311-S – 16-Port Sequencer – Fast Multiport Gas Sampler 

D.4 Valve Control Configurations 
For all models of Picarro analyzers, the rotary valve control is disabled in the 
factory default setting. The solenoid valve control, however, is enabled by default 
for all solenoid valve connectors.  

To configure an analyzer for operation with an A0311 or A0311-S rotary valve, the 
user must first confirm that the COM port chose on the back of the instrument for 
connection to the rotary valve is consistent with the COM port specified in the 
Setup Tool. Refer to Port Manager Tab located in Section A.1 Setup Tool for 
instructions to change to rotary valve configuration (the Valve Sequencer MPV 
field) and to ensure the correct COM port is enabled. 

 
CAUTION 

Only use supported 12V, <500 mA, solenoids (listed above in Section D.1). Using 
unsupported solenoids may result in damage to the power board. 

D.5 Setting Up Solenoid Valves 
The Valve Sequencer software can control up to six solenoid valves. Each valve 
should operate using 12 VDC with a maximum quiescent current of 500 mA. Most 
analyzers come with a valves cable that can be connected to the solenoid valves, 
and if not, one can be purchased by contacting support@picarro.com. 

 

 
CAUTION 

Be careful to avoid shorting the solenoid valve output pins, as this will blow the 
relays on the power board, requiring a costly replacement. 
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The valve connector cable should be connected to the 15-pin connector at the 
lower left corner of the analyzer. There are six pairs of wires with connectors 
labeled V1, V2, … V6 with 2-pin female Molex connectors (Molex #43020-0200) 
for connection to the solenoid valves. For valves wired with matching Molex 
connectors, connect V1 to the solenoid valve 1, V2 to solenoid valve 2, etc. Do 
not connect the solenoid valve to the analyzer ground – use only the provided 
electrical connectors. 

D.6 Setting up a Rotary Selector Valve 
The (null modem) 9-pin female connector cable should be attached to its 
corresponding 9-pin male port (COM 2) on the analyzer. The other end of the 
cable connects to the 9 pin port on the A0311. Please note the 9-pin connector 
cable is not supplied with the instrument – only as part of the A0311 kit.  

D.7 External Valve Sequencer Software Overview 
The External Valve Sequencer software allows the user to define a sequence of 
(repeating) steps within which rotary valve positions and/or solenoid valve 
positions can be defined uniquely at each step. 

Opening the Sequencer 
From the CRDS Data Viewer Tools drop-down menu, select Show/Hide Valve 
Sequencer GUI. The Picarro valve sequencer window will be displayed (Figure 
86), but typically sitting behind the main GUI. Hitting alt-tab brings the Valve 
Sequencer GUI to the front. 
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Figure 86: Launching the Valve Sequencer GUI 

Valve Sequencer UI Menus 
The sequencer GUI provides the dropdown menu choices shown here. 

 

Figure 87: Valve Sequencer UI Dropdown Menus 

For the following functional descriptions, Figure 88 shows a full view of an 
example sequencer UI. 
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Figure 88: External Valve Sequencer UI 

The Current Step #, the Remaining Time (min), and the Current Valve State 
are shown in the topmost row of the valve sequencer command window. The 
duration of each step is set in decimal minutes; for example, 15 seconds would be 
entered in as 0.25 minutes. 

While a sequence is inactive, Current Step # will typically read “0.”  Once the 
user has selected Start Sequence from the Action menu, or once the user has 
hit Apply from the GUI, the Current Step value will change to 1, corresponding to 
the first step defined below it, and will continue through the steps, returning to 
Step 1 once the last step is completed.  

If a user wishes to perform a set of steps only once, they may set a final step with 
a very long duration, or wait until the sequence is finished, and at the end of the 
last step, click Stop Sequence from the Action menu. 

Current step and valve state 
status panel (when sequencer 
is running) 

Sequencer 
configuration controls 
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Under Action, the Go to First Step menu item restarts the sequence from step 1. 
When the first step in the sequence starts, the “Current Step” value will change to 
“1”. This will begin the sequence if the sequence is currently active. 

D.8 Programming and Saving a Valve Sequence 
Each “step” in the sequence can be used to set the rotary valve to a given position 
or activate selected solenoid valve(s) for a set period. Multiple steps can be 
carried out in sequential order to switch between different gas sources, flush out a 
manifold, or to perform other gas handling operations.  

1. Create the number of desired steps in the sequence by clicking the 
up/down arrow for Total Steps. 

2. For each step, select the box for each solenoid valve to be opened. The 
checkmark in the Current Valve State window indicates a solenoid 
valve is set to its “normally closed” value in the case of a 3-way, or to its 
“open” value in the case of a 2-way on/off valve. The positions from left 
to right correspond to solenoid valves V1 to V6. 

3. The rotary selector valve position can be set in the column labeled Rot. 
Valve Code. Enter the number that corresponds to the desired valve 
position. A value of 1 in this field corresponds to position 1 on the rotary 
valve. Only one rotary position can be selected per step.  

4. The upper right box, Current Rot. Valve Code, displays the current 
value while a sequence is active. It should be green if a rotary valve is 
connected, turned on, and detected by the software. If the box is grayed 
out, the rotary valve is not detected (if so, consult your rotary valve 
manual). 

5. For each step, set the desired Duration. This is determined by the value 
entered in the Duration (min) field, where the duration of the step is in 
minutes. If duration values are set to <0.1 minutes, they may not be 
carried out accurately. 

6. The Valve Code column (not used with the rotary valves) is a 
configuration-dependent, read-only display field that shows the total 
state of that particular step in a numerical binary sum of form 2(Valve Number 

-1). When powered, the following valve values are produced, and then 
added together for the final Valve Code. 

Valve 1 Powered = 2(Valve number-1) = 2(1-1) = 1 

Valve 2 Powered = 2(Valve number-1) = 2(2-1)= 2 

Valve 3 Powered = 2(Valve number-1) = 2(3-1)= 4 

Valve 4 Powered = 2(Valve number-1) = 2(4-1) = 8 

Valve 5 Powered = 2(Valve number-1) = 2(5-1)= 16 

Valve 6 Powered = 2(Valve number-1) = 2(6-1)= 32 
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The maximum displayable value is 63 (=1+2+4+8+16+32), when valves 
1-6 are all powered. All other combinations of valves are unique binary 
sum values which denote the specific combination of any of the six 
valves.  

This Valve Code value active at a particular point in time can be shown 
in the main Picarro software GUI as SolenoidValves or sometimes 
ValveMask (this may require going to Settings > Service Mode > 
password picarro). The Rotary valve code can be displayed as 
MPVPosition. 

 
Above is a 15 minute sequence, currently on position 1, using solenoid valves only, in 
positions 3, 5, and 6 to determine flow path . 

Figure 89: Example 15 Minute Sequence 

7. Once the valve sequence has been programmed, it can be saved by 
selecting Save Valve Sequence File under the File menu (Figure 87). 
The sequence may be saved with any name the user chooses.  
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D.9 Loading and Running a Saved Sequence 
Loading a Saved Sequence 

1. Under the File menu, select  Load Valve Sequence.  

All the sequence files are in: 

C:\Picarro\G2000\InstrConfig\ValveSequencer\Name of the Sequence File 

2. To load an existing valve sequence file, select the desired sequence 
name.  

If the user has been running a different sequence from the one that was 
loaded, the user needs to press Run Next Step to initialize the newly 
selected sequence, or alternately go to File > Go To First Step and Start 
Sequencer. 

Running a Sequence 
1. Under the Action menu, select Start Sequencer. 

This selection will change to Stop Sequencer once the sequence starts. 
(The sequencer should be activated if it was disabled, but not necessarily 
to change from one sequence to another.) The sequence will repeat itself 
indefinitely until disabled or the software is exited.  

2. Once the sequencer is running, the user can select Hide Sequencer 
Interface under the Action menu; the sequence will continue to run 
even with the UI hidden, and will automatically continue if the instrument 
ever loses power from the wall and restarts after power is restored. 
(However, the timing of the sequence will be offset relative to the 
intended cadence.)   

3. To bring the sequencer interface back into view, from the main Picarro 
GUI, go to Tools > Show/hide Valve Sequencer again. 

Skipping Steps or Advancing to a Particular Step 
If desired, the valve sequence can be forwarded to the next step of the sequence 
by clicking the Run Next Step button on the UI. To jump to a particular step, 
increment the Run Step # field and click Apply. 

Stopping the Sequencer  
1. Under the Action menu, select Stop Sequencer.  

This will leave all valves in their current state. In some situations, it is 
convenient to program the last step in the sequence to be a safe or 
default valve state.  
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2. Should the user need to put the solenoid or rotary valves into a 
safe/default state, the sequencer can be advanced to the last step using 
the Run Next Step button.   

Resetting Valves 
Under the Action menu, selecting Reset All Valves will deactivate/reset all 
valves to their default state.  

Valve Sequencer Data Records 
For each individual measurement the analyzer makes, the valve codes and rotary 
valve positions corresponding to the valve state(s) at that point in time are saved 
alongside the concentration data as long as the variable is selected in the User 
Setup utility, Data Logger tab, Data Columns window.  

If the variable is not available in that window, from the User Setup > Settings 
menu, select the service mode, password picarro, and then select the value from 
the variables that populate into the Data Columns window.  

If no solenoid valves are present, the codes will be recorded regardless of 
whether a valve is connected.  

If no steps are defined, and no sequence is active, these values will display 0. 

D.10 Scheduling a Sequence 
Users may schedule a sequence to start at a particular time in the future, often at 
the top of the hour, or at midnight for a recurring sequence with an hourly or daily 
cadence. The Schedule Sequence button is typically grayed out when the user 
shows the valve sequencer because the start time has passed. To begin a run in 
the future, select the desired date under Start Date, and the desired time under 
Start Time. When both values are in the future, the Schedule Sequence button 
will become active, and the user may click it. When the scheduled time arrives, 
the sequence will start itself automatically. 
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APPENDIX E – Relative Humidity 
Conversion  

H2O Concentration (C) is reported in units of parts per hundred or percent (%) and is a 
volumetric fraction of water vapor to total (wet) gas. Via the ideal gas law, the 
concentration can be related to the water vapor pressure (PW) and the total pressure (P). 

𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 = 100 ∙
𝑃𝑃𝑊𝑊
𝑃𝑃

 

A popular way to express volumetric concentration when working with humidity is in 
terms of total (dry) gas. 

𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 = 100 ∙
𝑃𝑃𝑊𝑊

(𝑃𝑃 − 𝑃𝑃𝑊𝑊) 

The two concentration definitions can be related by 

𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 = 100 ∙𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤
(100−𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤)

 or 𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 =
100∙𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑

�100+𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑�
 

Relative Humidity (RH) is the percentage of water vapor pressure to the saturated water 
vapor pressure (PWS). 

𝑅𝑅𝑅𝑅 = 100 ∙
𝑃𝑃𝑊𝑊
𝑃𝑃𝑊𝑊𝑊𝑊

 

There are several empirically generated equations that provide the saturation vapor 
pressure as a function of temperature (T). A simple and effective relationship for use 
within a temperature range of -45 °C to 60 °C is provided by the Mangus formula with 
coefficients adjusted by Sonntag [1]. 

𝑃𝑃𝑊𝑊𝑊𝑊 = 𝛼𝛼 ∙ 𝑒𝑒�
𝛽𝛽∙𝑇𝑇
𝑇𝑇+𝜆𝜆� 

Where, 𝛼𝛼  = 4.584 Torr, 𝛽𝛽 = 17.62 and λ = 243.12 °C 

Combining the equations shown above yields the final relationship for converting the wet 
and dry definitions of concentration to relative humidity. 

 
For example, a wet concentration of 1.5% H20 at 18.0 °C and 760.0 Torr yields a 
relative humidity of 73.8%. 

A dry concentration of 1.5% at 18.0 °C and 760.0 Torr yields a relative humidity of 
72.7%. 
[1] Sonntag D.: Important New Values of Physical Constants of 1986, Vapour Pressure Formulations based 
on the ITS-90 and Psychrometer Formulae; Z. Meteorol.70 (1990) 5, 340-344 

𝑅𝑅𝑅𝑅 = 𝐶𝐶𝑤𝑤𝑤𝑤𝑤𝑤 ∙
𝑃𝑃
𝛼𝛼 ∙ 𝑒𝑒

−�𝛽𝛽∙𝑇𝑇𝑇𝑇+𝜆𝜆� =  
100 ∙ 𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑

�𝐶𝐶𝑑𝑑𝑑𝑑𝑑𝑑 + 100�
∙
𝑃𝑃
𝛼𝛼 ∙ 𝑒𝑒

−�𝛽𝛽∙𝑇𝑇𝑇𝑇+𝜆𝜆� 
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APPENDIX F – Introduction to CRDS 
Technology 

Picarro analyzers use time-based, optical absorption spectroscopy of the target gases to 
determine concentration in a sample. They are based on wavelength-scanned cavity 
ring-down spectroscopy (WS-CRDS), a technology in which light travels many times 
through the sample, creating a very long effective path length for the light to interact with 
the target gas, thus enabling excellent detection sensitivity in a compact and rugged 
instrument.  

The Picarro analyzer is comprised of two modules: 

• The Analyzer contains the spectrometer, sample chamber, and a computer with a 
hard drive to store and analyze data. The single analyzer module controls the 
operation of the system and converts spectroscopic measurements into gas 
concentration data. 

• The External Vacuum Pump draws the sample gas through the instrument. 

F.1 Cavity Ring-Down Spectroscopy (CRDS) 
Nearly every small gas-phase molecule (e.g., CO2, H2O, H2S, NH3) and 
isotopologue (e.g., H2

18O, 13CO2, 15N14N16O) uniquely absorb specific wavelengths 
of near-infrared light. The strength of the light absorption is related to the 
concentration of a molecule in a sample and the distance that light travels through 
the sample, called the path length.  

Conventional infrared spectrometers are typically only sensitive enough to detect 
trace gases at levels in the part-per-million. Cavity Ring-Down Spectroscopy 
(CRDS), on the other hand, is one thousand to one million more times sensitive.  

The increased sensitivity of CRDS is due to the design of the sample cavity and 
the time-based measurement. In the cavity, a series of mirrors reflects the infrared 
light through the sample, increasing the path length. For a Picarro cavity of only 
25 cm in length, the effective path length of the cavity can be over 20 kilometers.  

In Picarro analyzers, light from a single-frequency laser enters a cavity where 
three mirrors reflect the laser light as seen in Figure 91. The light enters through 
the mirror closest to the laser, bounces off the angled mirror in the lower right 
corner of the cavity, travels to the hemispherical mirror at the top of the cavity, 
bounces toward the mirror in the lower left corner of the cavity, and then returns to 
the first mirror. This motion becomes a continuous traveling light wave, which is 
represented by the dark orange path in Figure 91. 
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Figure 90: Schematic of Picarro CRDS Analyzer Cavity 

When the laser is on, the cavity quickly fills with laser light. A small amount of the 
laser light is transmitted through the mirror closest to the photodetector, which 
turns the incident light into a signal that is directly proportional to the light intensity 
in the cavity. 

When the photodetector signal reaches a threshold level (in a few tens of 
microseconds), the laser is turned off. The light contained within the cavity 
continues to bounce between the mirrors (about 40,000 times). Since the mirrors 
have slightly less than 100% reflectivity (99.999%), the light inside the cavity 
steadily leaks out of the cavity. The intensity of the light reaching the detector 
decreases, falling exponentially until it reaches zero. This decay, or “ring-down,” is 
measured in real time by the photodetector. 

F.2 Relating Ring-Down Time to Absorption 
Intensity 

The time it takes to ring-down is inversely related to the total optical loss in the 
cavity, including the strength of molecular absorption at a given wavelength of 
light. For an empty cavity, the time it takes for the intensity to decrease by a given 
percent is determined solely by the reflectivity of the mirrors. A cavity containing 
gas that absorbs light will have a shorter ring-down time than an empty cavity. As 
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the light circulates in a cavity with a gas sample, the molecular absorption by the 
gas results in a decrease of the light intensity. 

Determining absorption intensity at a specific wavelength requires comparing the 
ring-down time of an empty cavity to the ring-down time of a cavity that contains 
gas (Figure 92). A cavity can be empty if it contains no gas; it will also appear 
empty if the molecules of the sample inside the cavity do not interact with the 
specific wavelength of light.  

Picarro instruments gather measurements from an “empty” cavity by switching the 
light to wavelengths that are not absorbed by the target molecules. The analyzer 
subsequently measures ring-down times at wavelengths that are absorbed by the 
target gas. The analyzer automatically and continuously compares these two 
types of ring-down times, and the software uses those comparisons to calculate 
absorption intensities. 

 

Figure 91: Light Intensity as Function of Time in CRDS System 

F.3 Converting Absorption Intensity to 
Concentration 

Plotting the absorbance at each measured wavelength generates an optical 
spectrum. This spectrum contains absorbance peaks that are unique to each 
molecule in the sample. The height of a particular absorption peak is proportional 
to the concentration of a molecule that generated the signal.  
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The height of the peak is calculated by subtracting the maximal absorbance from 
the baseline absorbance. Figure 73 shows a plot of ideal optical spectra with a 
clean, uniform baseline on either side of the absorption peak. 

 

Figure 92: Absorption Spectral Curve 

However, optical spectra often contain several absorption lines, nested closely 
together. A particular absorption peak may be visible between lines, but the 
absorption may not return to the baseline before it rises in response to another 
molecule.  

Picarro analyzers calculate the baseline underneath a poorly resolved peak by 
modeling the absorption peaks from other surrounding molecules and subtracting 
contributions from neighboring peaks to the absorption intensity.  

F.4 Spectral Precision and High Sensitivity 
Measurements 

Picarro analyzers contain two features that provide high spectral precision:  

• A proprietary wavelength monitor (WLM) that measures the absolute laser 
wavelength to a precision that is a few orders of magnitude narrower than 
the spectral linewidth: Picarro’s patented WLM measures absolute laser 
wavelength to a precision more than 1,000 times narrower than the 
observed Doppler-broadened linewidth for small gas-phase molecules. 
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The instruments lock the laser to the WLM, and then the monitor tunes to 
wavelengths known to be maximally and minimally absorbed by the target 
molecule. The result is closely clustered absorption intensities, measured 
at wavelengths just before peak absorption, at peak absorption, and just 
after peak absorption, as the absorbance returns to the baseline.  

• Precise temperature and pressure control in the sample cavity: Accurate 
absorption measurements at precisely known wavelengths account for 
little unless the temperature and pressure of the CRDS measurement 
cavity are known. The observed line intensity and shape depend on the 
temperature and pressure inside the sample cavity. Small temperature 
and pressure instabilities can result in large concentration errors due to 
fluctuating peak heights and baselines. To completely minimize instrument 
measurement drift, temperature and pressure must be actively stabilized 
to constant values.  

For precise temperature control, the sample cavity is surrounded by layers of 
thermally insulating material to provide a high degree of passive thermal stability. 
The cavity is further actively stabilized by means of a solid-state heating system 
locked to the output of a thermal sensor. This enables the temperature of the 
cavity to be within 20 mK of the set temperature.  

For precise pressure control, the cavity pressure is monitored using a high-
linearity pressure transducer. The system computer uses this pressure data in a 
feedback loop to control proportional valves that adjust the inlet and outlet gas 
flow of the cavity. 
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APPENDIX G – Limited Warranty 
Picarro, Inc. warrants its Products to be free from defects in material and workmanship 
and to perform in the manner and under the conditions specified in the Product 
specifications for twelve (12) months from shipment. 

This warranty is the only warranty made by Picarro with respect to its Products and no 
person is authorized to bind Picarro for any obligations or liabilities beyond this warranty 
in connection with its Products. This warranty is made to the original Purchaser only, is 
non-transferable and may only be modified or amended by a written instrument signed 
by a duly authorized officer of Picarro. Sub-systems manufactured by other firms, but 
integrated into Picarro Products, are covered by the original manufacturer’s warranty 
and Picarro makes no warranty, express or implied, regarding such sub-systems. 
Products or parts thereof which are replaced or repaired under this warranty are 
warranted only for the remaining, un-expired portion of the original warranty period 
applicable to the specific Product replaced or repaired. 

WARRANTY DISCLAIMER 

THE FOREGOING WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER 
WARRANTIES WHETHER WRITTEN, ORAL, OR IMPLIED, AND SHALL BE THE 
PURCHASER’S SOLE REMEDY AND PICARRO’S SOLE LIABILITY IN CONTRACT 
OR OTHERWISE FOR THE PRODUCT. PICARRO EXPRESSLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE. 

The Purchaser’s exclusive remedy with respect to any defective Product shall be to have 
Picarro repair or replace such defective Product or credit the Purchaser’s account, 
whichever Picarro may elect in its sole discretion. If it is found that any Product has been 
returned which is not defective, the Purchaser will be notified, and such Product returned 
at the Purchaser’s expense. In addition, a charge for testing and examination may, at 
Picarro’s sole discretion, be made on any Product so returned. 

These remedies are available only if: 1) Picarro is notified in writing by the Purchaser 
promptly upon discovery of a Product defect, and in any event within the warranty 
period; 2) Picarro’s examination of such Product discloses to Picarro’s satisfaction that 
such defects actually exist and the Product has not been repaired, worked on, altered by 
persons not authorized by Picarro, subject to misuse, negligence or accident, or 
connected, installed, used or adjusted otherwise than in accordance with the instructions 
furnished by Picarro. 

The following warranty conditions shall apply to all Picarro, Inc. products unless 
amended by a written instrument signed by a duly authorized officer of Picarro: 

ADJUSTMENT – No electrical, mechanical, or optical adjustments to the product(s) are 
permitted. 
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PARTS AND LABOR - New or factory-built replacements for defective parts will be 
supplied for twelve (12) months from date of shipment of the product. Replacement parts 
are warranted for the remaining portion of the original warranty period. There will be no 
charge for repair of products under warranty where the repair work is done by Picarro, 
Inc.  

NOT COVERED BY THE WARRANTY – Damage to any optical surface from improper 
handling or cleaning procedures. This applies specifically to those items subjected to 
excess laser radiation, contaminated environments, extreme temperature, or abrasive 
cleaning. Damage due to ESD, abuse, misuse, improper installation or application, 
alteration, accident, negligence in use, improper storage, transportation, or handling. No 
warranty shall apply where the original equipment identifications have been removed, 
defaced, altered or where there is any evidence of alterations, adjustments, removal of 
protective outer enclosure, any attempt to repair the product by unauthorized personnel 
or with parts other than those provided by Picarro, Inc.  

DAMAGE IN SHIPMENT - Your analyzer should be inspected and tested as soon as it is 
received. The product is packaged for safe delivery. If the product is damaged in any 
way, you should immediately file a claim with the carrier or, if insured separately, with 
the insurance company. Picarro, Inc. will not be responsible for damage sustained in 
shipment. All Picarro products are F.O.B. origin, shipped from the Picarro factory or 
Picarro distributor. The price of all Products, unless otherwise specifically stated, is Ex- 
Works, Sunnyvale, CA as defined by Incoterms, 2020. The cost of normal packaging for 
shipment is included in the invoiced price. Where Buyer specifies special packaging, a 
charge will be made to cover any extra expense. 

CLAIMS ASSISTANCE - Call Picarro, Inc. Customer Service or your local distributor for 
assistance. Give our representative the full details of the problem. Helpful information or 
shipping instructions will be provided. If requested, estimates of the charges for non-
warranty or other service work will be supplied before work begins. 

RETURN PROCEDURE - Customers must obtain a Return Merchandise Authorization 
Number from Picarro, Inc. prior to returning units. Products being returned for repair 
must be shipped in their original shipping cartons to avoid damage. 

 



 

 

 

 

 

 

 

 

 

 

 

About Picarro 
Picarro is a leading provider of solutions to measure greenhouse gas (GHG) concentrations, 
trace gases, and stable isotopes across many scientific applications, along with the energy and 
utilities markets. Our patented Cavity Ring-Down Spectroscopy (CRDS) is at the heart of all 
Picarro instruments and solutions, enabling the detection of target molecules at part per billion or 
better resolution. 

Product Support 
Utilize Picarro support resources for product support. Join the Picarro community to ask 
questions and get answers, search the document library for datasheets and user 
manuals, download software, and purchase products and replacement parts.  

Access to online User Manuals is available to all registered Picarro customers with login 
credentials. If you do not yet have an account, please email us at support@picarro.com to 
request access. Note must be a registered user and logged in to access the following 
resources: 

• Picarro Document Library 

• Picarro Community (Forums) 

• Picarro Software Downloads 

• Picarro Literature (Scientific Resources) 

• Picarro Web Store 

Contact Picarro for questions regarding specific applications and additional information. 

US Technical Support:  International Technical 
Support: 

 Customer Service: 

Email: support@picarro.com   Email: support@picarro.com  Email: support@picarro.com 

Phone: + 1 408 962 3991  Phone: +31 85 888 1650  Phone: + 1 408 962 3992 

 

https://www.picarro.com/support/documents
https://www.picarro.com/support/community
https://www.picarro.com/support/downloads
https://www.picarro.com/support/literature
https://www.picarro.com/support/literature
mailto:support@picarro.com
mailto:support@picarro.com
mailto:support@picarro.com
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